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MacBook For Beginners is the first and only choice
if you are new adopter and want to learn
everything you'll need to get started with your new
device. This independent guide is crammed with
helpful guides and step-by-step fully
illustrated tutorials, written in plain easy to follow
English. Over the pages of this new user guide you
will clearly learn all you need to know about out of
the box set up, getting to grips with the more
advanced features and discover a huge array of
amazing apps. With this unofficial instruction
manual at your side no problem will be
unsolvable, no question unanswered as you learn,
explore and enhance your user experience.

)

Papercut

www.pclpublications.com



.| Contents }

Contents

6 50 Monterey’s Dock — For Most-used Apps
The MacBook Range 51  Customising the Dock

8 The Apple Silicon MacBook Air 562 Notifications — See What's Going On

10 The Apple Silicon 13-Inch MacBook Pro 563 Creating and Removing Notifications

12 The 14 & 16 inch MacBook Pro’s 54  Working with Monterey’s Widgets

17  Apple’s Current MacBook Pro Range 565 Editing Widgets

18  New Processors for New Macs 56 The Spotlight Feature — Search Your Mac
20 The Road to Monterey 568 Launching Apps —And Quitting Them

22  An Introduction to macOS Monterey 60 Setting Up Email — For the Mail App

61  Setting Up Other Emails

62 Installing New Apps — On Your Mac

24 First Steps with MacBook 63 Installing Apps from the App Store
64 Third-party Apps — On Your Mac

26  Set Up Your Mac - For the First Time

29 Reset to Factory Conditions

30 Using Touch ID — On the Latest Macs
31  Making Purchases with Touch ID

32  Welcome to the Monterey Desktop 70  Set Up a New Safari Home Page
34 Customising the Monterey Desktop 71  Add Tools to the Toolbar

35 Auto-changing Wallpaper 72 The Safari Start Page

36 Gesture Controls — On Your Trackpad 73 The Tabs Audio Indicator
74 The Safari Reader View

68  Safari — Your \Web Browser

37  Switching Between Full-screen Apps

38  Dark Mode —And Night Shift 75  Getting More from Safari

39 Desktop Stacks — For Organisation 76  Mail - Send & Receive Email

40  Getting Online — With Wi-Fi or Ethemet 83  Home — For the Smart Home

40  Using Public Wi-Fi 84  Music — Play Your Tunes

41 Going Online with Ethernet 85  Importing Your CD’s into Music

42 Monterey’s Menus — A Key Mac Feature 86 Cancelling Your Subscription

44 Using Finder  Files, Folders & Apps 2 TewE—SlicsArd Fealnes

45 How to Relaunch Finder 89  News Shared with You

47  Perform Tasks Within the Finder 20 Phfs - Manage Yoor Images
192 Glossary of Mac and Computing Terms

49 Accessing iCloud Drive

4 | www.pclpublications.com



[ Contents

& FaceTime Edit Video Window Help W @ T Q - MonJun7 9:41AM

1 ~ Dream Team
& leeandnim.co &
[ EE&NIM AR

To: Dream Team

We've been trying to get
designs together for the
new season’s lineup.

Juan, how'd the shoot go?

I'd love to see what we :
could put on the landing

page.

“For beqgini the bOX, and

ad gestures and
the basics and
fari web browser,

Can You Run
macOS Monterey?

Older Macs cannot be updated to the new operating system, so if you want to MacEooleAinS Eary 2015 ancltar
upgrade your Mac to macOS Monterey, it must be one of the following models: sicken Fus Bl bl ey
All Apple Silicon Macs

MacBook Early 2016 and later

www.pclpublications.com | &



The MacBook Range

Pro or Air? Apple Silicon processor or Intel? Portability or power? Buying

your first MacBook can be bewildering but we’re here to help. We bring you
a guide to the current MacBook models, their strengths and weaknesses and
an outline of their expansion options and range of connectivity ports.

MacBook Air

The new MacBook Air, 13-inch MacBook Pro, and Mac mini are now powered by M1, Apple’s revolutionary chip.

Apple Silicon is Here!

Apple has lifted the lid on the first of its new generation of MacBook processors. Let’s take a look at why they’re
expected to take MacBooks to the next level.

Apple has been changing the processors used in the MacBook.
Instead of Intel central processing units, or CPUs, the company
is switching to its own Apple Silicon chips, the first of which is
the M1 processor. It's already unveiled the first computers
running on the new processors. As a CPU is at the heart of a
computer, executing the instructions that make up a software
app, this is very big news indeed.

It isn't the first time Apple has changed the Mac’s
processors. In 2006, it dropped the IBM PowerPC
processor in favour of Intel’'s chips, and before that, the
Motorola 68040 series was abandoned for the PowerPC
CPUs. Over the next few years, it makes a change once
again as Intel CPUs are gradually phased out, and are
replaced by Apple Silicon processors. But why?
According to Apple, the changeover makes MacBooks

6 | www.pclpublications.com

faster and more efficient, while using less power, which is
very important for battery life in notebooks. According to
Johny Srouji, Apple’s vice president for hardware
technology, “The first thing this will do is give the MacBook
a whole new level of performance.”

Also, as the Apple Silicon chips are based on the same
architecture as Apple’s mobile devices, it will be easier to
develop for MacBooks, iPads and iPhones together, creating
one app that works on all platforms. We're promised Apple
Silicon MacBooks can run iOS and iPadOS software natively,
and converting apps from one platform to another is a quick
and simple affair.

The first of the Apple Silicon CPU series was the M1 chip,
and on 10th November 2020, Apple lifted the lid on the first
Macs that use it. And they looked pretty special.




The M1 CPU

Apple is no stranger to designing and manufacturing
processors. It has been making chips for the iPhone, iPad
and iPod touch for years. But the new M1 CPU, Apple’s most
powerful chip yet, is its first designed for the MacBook. The M1
is an entire system on a single chip. In the past, a MacBook
needed several chips running alongside the CPU. There was
a controller for data transfer in and out, and another for the
Thunderbolt ports alone. Solid state memory required more
chips, as did the Apple T2 for security features. Not any more.
The M1 combines all these technologies into a single unit,
which is great for efficiency, and therefore, performance.
The M1 chip uses five nanometer technology. What this
means is an individual transistor, the things that do the work
in a processor, is just five billionths of a metre large;
the same size as ten atoms. Smaller transistors
makes for greater speed and efficiency, and also —
crucially — it means you can cram more of them onto
a smaller area. The M1 packs in an amazing 16 billion
transistors, the most Apple has ever put on a chip.
The M1 processor also features the world’s fastest
CPU core in low-power silicon, the world’s best
CPU performance per watt and the world’s fastest
integrated graphics in a personal computer. Clearly
designed with notebooks in mind, a great deal of
attention has been paid to keeping power consumption
low, while ramping up its capabilities. As a result, M1
delivers up to 3.5x faster CPU performance, up to 6x
faster GPU performance, and up to 15x faster machine
learning, all while enabling battery life up to 2x longer
than previous-generation MacBooks.

CPU Fabric | |GPU DRAM
|
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I:' Neural DRAM
= Engine
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|
Cache
Unified Memory Architecture (UMA) combines the comp ’s y and its

processor, meaning all parts of the chip can access the RAM quickly and easily.

The MacBook Range

M1 is the most powerful chip Apple has ever created.

But how does it achieve these figures? Each M1 chip has
eight cores, which means it can handle eight tasks at once. Four
of those cores are optimised for high performance, for when
carrying out processor-intensive tasks such as video encoding
or image processing. Apple claims the four high-efficiency
cores deliver outstanding performance at a tenth of the power.
The other four cores are optimised for efficiency, meaning the
chip is less draining on the battery when doing regular tasks
such as web surfing, word processing and so on.

The M1 also includes an integrated graphics processing unit
(GPU). Featuring up to eight powerful cores capable of running
nearly 25,000 threads simultaneously, the GPU can handle
extremely demanding tasks with ease, from smooth playback
of multiple 4K video streams to rendering complex 3D scenes.
With 2.6 teraflops of throughput, M1 has the world’s fastest
integrated graphics in a personal computer.

“The M1 ushers in a whole new era for the MacBook,”
said Johny Srouji, Apple’s senior vice president of Hardware
Technologies. “When it comes to low-power silicon, M1 has
the world’s fastest CPU core, the world's fastest integrated
graphics in a personal computer and the amazing machine
learning performance of the Apple Neural Engine. With its unique
combination of remarkable performance, powerful features, and
incredible efficiency, M1 is by far the best chip we've ever created.”

www.pclpublications.com | 7



The MacBook Range ]

The Apple Silicon MacBook Air

The last refresh brought a host of new features to the MacBook Air, without making it any less portable.

The first Apple Silicon-based Mac that Apple unveiled is the
13-inch MacBook Air, the ultra-portable laptop that packs a
seriously powerful punch into a small and light package.

The M1 CPU makes the MacBook Air 3.5x faster than the
previous generation, with up to 5x faster graphics, the biggest
generational leap ever for a MacBook Air. You can play
modern, graphically immersive games at significantly higher
frame rates; great news for Apple Arcade subscribers.

Video editors will also appreciate the MacBook Air. Before,
Apple’s ultra-portable wasn’t considered suitable for such a
processor-intensive task, but now you can edit multiple
streams of full quality 4K video without dropping a frame.
Although the higher-end and the cheaper MacBook Airs use
the same M1 processor, the cheapest model only has a
seven-core GPU, while the more expensive notebook — as well
as the rest of the new Apple Silicon Macs — have eight
graphical cores.

The MacBook Air out-performs comparable Windows
notebooks by a significant degree too. According to Laura
Metz, Apple’s Mac Product Line Manager, it's up to three times
faster than the best-selling Windows notebook in its class, and
is faster than 98% of PC laptops sold in the last year.

8 | www.pclpublications.com

The solid state storage used in the MacBook Airs is up to
2x faster than the previous generation, thanks to the M1
storage controller and advanced flash technology. this makes
tasks such as previewing large files or transferring data
between external and internal storage are much quicker.

Perhaps the most important advance made by the
MacBook Airs is their battery life. Excellence in this
department is nothing new for Apple’s thinnest and lightest
notebook, but thanks to the M1’s efficiency, the newer Airs
take it to a whole new level. You can wirelessly surf the web for
up to 15 hours on a single charge or play back videos for 18
hours, which is six hours longer than before. Video calling is a
notoriously power-hungry task, but you can go for up to twice
as long with the Air. Video chatters will also appreciate the
improved picture quality when streaming from your notebook’s
camera, and as the new Airs are fanless, even when carrying
out processor-intensive tasks it still operates silently.

Other features worthy of note are Touch ID, which lets you
unlock your Mac with your fingerprint, and support for P3 wide
colour for an even more vibrant, true-to-life Retina display.

As before, the M1 MacBook Air
is available in three colours;
Gold (pictured here), Silver and
Space Grey.

e —————




The Apple Silicon MacBook Air
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MacBook Air

The new Apple Silicon M1 chip is at the heart of the new 13-inch MacBook Air.

Suitability.

All-day battery life and lightweight portability. A great
choice for those who carry their notebook around a lot.

Price. Ports.

Most expensive: n Two USB-C ports
£1,249, $1,249, 1.363,70 €

Cheapest model:
£999, $1999, 1.100,50 €

Headphone port

www.pclpublications.com | 9




The MacBook Range

The Apple Silicon 13-Inch MacBook Pro

The most-popular MacBook Pro size gets the first injection of Apple Silicon to make this mini-beast.

In November 2020, Apple unveiled a M1-powered MacBook Pro,
but only the 13-inch version. The M1 chip makes its appearance
in the two cheaper notebooks, which can be configured with 8GB
or 16GB of memory and up to 2TB of storage.

The M1 eight-core CPU, when paired with the MacBook
Pro’s active cooling system, is up to 2.8x faster than the
previous generation, delivering improved performance when
compiling code, transcoding video, editing high-resolution
photos and more. The eight-core GPU is up to 5x faster,
allowing users to enjoy super smooth graphics performance
for gaming, video editing and design.

It's a pro-level notebook that offers improved pro-level results.
According to Apple, the 13-inch MacBook Pro is up to 3x faster
than the best-selling Windows laptop in its class. Machine
learning is up to 11x faster, and for on-device ML tasks that use

the M1 chip’s Neural Engine, the 13-inch MacBook Pro is now
the world’s fastest compact pro notebook.

We're told that compared to ‘the best selling Windows PC in
its class,” the M1 13-inch MacBook Pro is ‘up to 3x faster’ The
small print on Apple’s website says these Windows notebooks
are ‘production Intel Core i7-based PC systems with Intel Iris
Plus Graphics and the latest version of Windows 10," but
doesn't identify the make or model.

With up to 17 hours of wireless web browsing and up to a
staggering 20 hours of video playback, MacBook Pro delivers
up to twice the battery life of the previous generation and the
longest battery life ever on a Mac. If you find you often run out
of battery between charges, this is an excellent reason to
consider an upgrade.

——38
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With the M1 processor,
- the MacBook Pro delivers
= excellent performance and
battery life.
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MacBook Pro

“With M1, the 13-inch
MacBook Pro becomes
way more powerful and
way more pro.” Schriti
Haldea, Mac Product
Line Manager

O e e

Suitability.

The Apple Silicon MacBook Pro is a great notebook, but is limited
to a 13-inch screen and 16GB of memory. If that's okay with you,
get it.

Price. Ports.
Most expensive: EJ Two Thunderbolt/USB 4 ports

£1,799, $1,799, 2.075,30 €

Cheapest model:
£1,299, $1,299, 1.412,45 €

g Headphone socket
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The 14 & 16 inch MacBook Pros

Apple has released a new range of 14-inch and 16-inch MacBook Pros, replete with the new M1 Pro and M1 Max
processors. And that’s not all that’s new - or at least returning - either. Let’s take a look...

he new MacBook Pros represent a welcome mea culpa from Apple. For the last few years, each new

generation of high-end Mac notebooks have risen to new heights in some respects, but in others, taken the
MacBook Pro range in directions it didn’t really need to go. No one asked for the full range of connectivity ports
to disappear, to be replaced by Thunderbolt ports alone. The ‘butterfly mechanism’ keyboard design, which has
already been abandoned, was almost universally disliked and although the Touch Bar was very clever on paper,
itwasn’t highly regarded in practice.

With the new 2021 MacBook Pros, Apple has looked to its past as it moves into the future, correcting the
missteps that have held back the high-end notebooks while taking their power and efficiency to new levels.
You can buy a 14-inch or 16-inch model with the brand new - and incredibly powerful - Apple Silicon M1 Pro
essor, orifyou really want the fastest notebook Mac ever built, go for a 16-inch MacBook Pro with the top-

range M1 Max chip. But what, besides the processors, has changed in the new Apple MacBook Pros, and
we be excited?

1 The Notch
To give the screen more room without
compromising on the quality of the
FaceTime HD camera, the screen now
includes a ‘notch’, like the one found on the
iPhone. The Mac’s menu bar automatically
works around it, so nothing is lost.

2 Retina Displays

Smaller bezels and the notch around

the camera have allowed for a larger
screen area. The 16-inch MacBook Pro, for
example, actually has a 16.2-inch screen,
despite the enclosure being roughly the
same size as that of its predecessor.

3 The Apple Logo

Like other recent Apple notebooks, the
Apple logo no longer lights up when the
notebook s in use.

4 Aluminium Body

The new MacBook Pros have an aluminium
chassis. Unusually for a new Mac notebook
release, the new models are slightly larger
and heavier than the previous generation,
but this allows for a great thermal
architecture to keep them cool.

5 Connectivity: Right-Hand Side
On the right-hand side of the notebooks
there’s a HDMI port for connectingitto a
display or TV, a Thunderbolt 4 port and an
SD Card reader.

6 Connectivity: Left-Hand Side
On the left-hand side of the new MacBook
Pros are a MagSafe port for fast charging, two
Thunderbolt 4 ports and an audio socket.
The return of the MagSafe charging cable is
especially welcome.



Connectivity

Since 2016, Apple has taken a minimalist approach to notebook connectivity. All ports were
abandoned in favour of Thunderbolt ports alone, with other functions such as USB 2.0 and
HDMI taken over by adapters. Even the popular MagSafe charging was gone. The move was far
from universally popular, and thankfully, it's been reversed with the 2021 notebooks.

MagSafe charging is back, with a new MagSafe 3 port. The charging cable has the MagSafe
connector on one end and a USB-C plug on the other, which slots into the USB-C port on the
supplied power adapter. The great thing about MagSafe is that because the cable attaches
to the Mag magnetically, if it gets tugged while you're charging - maybe because you tripped
over it or the dog ran into the lead - the plug simply pulls away from the MacBook instead of
dragging it off your desk, to a possibly-damaging tumble. It's a great idea, and we're really glad
to see it back. If you don’t have your MagSafe cable handy, you can still charge through the
Thunderbolt ports using a regular USB-C cable.

HDMIis another returning connectivity port. With it, you can connect your MacBook Pro to
an external screen, or even a TV. The Thunderbolt ports support DisplayPort, so you can use
those too for connecting external displays. Notebooks with the M1 Pro processor can connect
up to two monitors, and if you’re lucky enough to have an M1 Max, you can plug in three
monitors and a 4K TV, all at once.

Finally, for SD Cards, the SDXC card reader makes a comeback. You can transfer your photos
and videos from your camera’s SD Card straight to your Mac, without having to use an adapter.

Apple’s experiment with only using Thunderbolt ports on its notebooks was a bold move,
but ultimately an unpopular one. We're delighted to see the return of HDMI, the SD Card reader

and most of all, MagSafe. MagSafe charging is back. Hurrah!

The Display

As you’d expect, the 2021 MacBook Pros have a Retina display. To be
precise, it’s a Liquid Retina XDR screen, a first for the MacBook Pro.
Another new display feature is ProMotion technology, featuring an
adaptive refresh rate up to 120Hz. ProMotion automatically varies
the refresh rate to match the motion of a user’s onscreen content to
help preserve battery life, and makes tasks more fluid and even more

screens as much space as possible, the new MacBook Pro’s responsive. Video editors can also lock in a refresh rate that is optimal
ms are placed in a notch in the centre of the upper border. for theirfootage.

MNM Triptych_For_Review_V2.ai (150.0%] *

Forthose interested in raw statistics, the new notebooks’ displays
[r— = [ deliver up to 1,000 nits of sustained, full-screen brightness, 1,600 nits

= - of peak brightness, and a 1,000,000:1 contrast ratio. The extreme
dynamic range brings HDR content to life with great detail in shadows,
brilliant highlights, deeper blacks and more vivid colours than ever
before. It has a P3 wide colour gamut and supports one billion colours.
In plain English, this means they look great.

They’re bigger, too. Thanks to the reduction in the size of the bezels
surrounding the screen, both models come with a larger display than
the previous generation. The 16-inch model offers an expansive 16.2-
inch display with 7.7 million pixels, the most ever on a Mac notebook.

- The 14-inch version has a 14.2-inch active area and a total of 5.9
i million pixels. That’s more pixels than the previous generation’s 16-
inch MacBook Pro offered.

One of the ways Apple has reduced the bezels and extended the
screen area is to put the camera in a ‘notch’, like that found on recent
iPhones. Here at Essential AppleUser Magazine we don’t think this
move will be universally popular, but the menu bar that runs along the
top of your screen automatically wraps around the notch, so you don’t
lose icons behind it. We hope third-party developers take account of
the notch with their own apps too.

y W mar e N B0 O
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The new notebooks’ Liquid Retina XDR screens have support
for up to one billion colours. It’s a fantastic notebook screen.
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New Camera and Audio

There’s a new camera in the MacBook Pro, and it’s a big
improvement on the previous generation’s FaceTime HD setup;
but maybe not big enough. The new MacBook Pro comes with a
1080p FaceTime HD camera — the best ever in a Mac notebook —
doubling resolution and low-light performance of even the 2020 CLGLETY-LY B T R R L L &’W L
MacBook Pros, which only offered 720p FaceTime HD. The camera
system taps into the powerful image signal processor (ISP) and T -
Neural Engine of M1 Pro and M1 Max for computational video The new camera, housed in a notch at the top of the screen, is twice as hi-res as
that enhances video quality, so users appear sharper with more the previous one, but lacks one or two features we’d like to have seen.
natural-looking skin tones.
And yet this camera is still not as good as the one used in recent P =
iPads, which offers facial recognition and a 12MP sensor as well / i “
as 1080p video. The iPad’s camera also has Center Stage, which
automatically keeps the subject in the centre of the screen during
FaceTime calls. There’s no sign of this useful feature in the MacBook
Pro’s camera system.
The audio features of the new notebooks have had a boost. The
built-in microphones, which Apple describes as ‘studio-quality, have
a noise floor that's up to 60% lower. A noise floor is the sound the
system itself creates; if it's too high, it can result in interference, or
an annoying background hum. Thus the lower the noise floor, the
cleareryour calls and voice recordings. | \
A high-fidelity six-speaker sound system features two tweeters \ \
that are nearly twice as large as those found in the previous S
models, and give a clearer soundstage. Four force-cancelling :
woofers that displace twice as much air as before make forin 80
percent more bass. They also go half an octave deeper. Play your
favourite tunes on a new MacBook Pro and you can hear notes that
were previously inaudible. - —
The sound system also supports spatial audio, which gives
you three-dimensional listening. When you're listening to music or The MacBook Pro’s six-speaker sound system gives full spacial audio. Great for
watching a movie in Dolby Atmos, you get a theatre-like experience. watching Dolby Atmos-capable movies or for playing video games:

The Battery

Given the increase in screen size, it’s inevitable
the 14-inch MacBook Pro can’t match the battery
life of last year’s M1-powered 13-inch model. To
be specific, the new notebook with an M1 Pro or
M1 Max chip can manage up to 17 hours before a
charge, while the 13-inch M1 model can run for up
to 20 hours. But when you bearin mind the last
Intel 13-inch MacBook Pro had a battery life of up
to ten hours, this is still majorly impressive.

The 16-inch notebooks powered by Apple
Silicon chips can run for up to 21 hours on a

single charge, which wipes the floor with the
- previous, Intel-powered 16-inch models, which
/d could only handle 11 hours. You can work for two
¢ days solid on a new 2021 MacBook Pro before
you need a recharge.

Fast charging with

MagSafe gives you up to
50 percent power in just Talking of recharging, with the exception of the
30 minutes. cheapest 14-inch model, the new MacBook Pros
come with a 96W USB-C Power Adapter, which -
| when coupled with the bundled USB-C to MagSafe

cable - allows for fast charging. You can charge
your new 2021 MacBook Pro up to 50 percent full
in just 30 minutes.
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The 14 & 16 inch MacBook Pros

The new thermal
architecture
enjoyed by the
latest MacBook
Pros allows the
fans to shift around
50 percent more air.
——

The new 16-inch
notebook is
marginally thicker
than the last one, but
it’s a fair exchange.

Thermal Efficiency

One particular hole Apple dug itself into in recent times is the desire to
make each new release thinner and lighter than the one before it. Once a
laudable aim, it carried on way past when it was helpful, with significant
compromises made to help shave a couple of millimetres off the case
size. The switch to only using Thunderbolt ports was in part inspired by
the desire to make notebooks thinner, as was Apple’s disastrous ‘butterfly
mechanism’ keyboard, which took up less space but was universally hated
by users. Thankfully, the company seems to have got over this particular
obsession. The new 2021 notebooks are a little thicker and heavier than
their predecessors, but this has allowed some significant performance
boosts, such as theirimproved thermal efficiency.

All computers produce heat when they operate. This can’t be helped.
Cooling systems are inevitable. The MacBook Pro’s enclosure is precisely
machined around an advanced thermal system that can move 50

The Keyboard

The new MacBook Pros have backlit magic keyboards
with a Force Touch trackpad and Touch ID. One thing
they don’t have is a Touch Bar. Introduced in 2016,

the Touch Bar replaced the physical function keys at
the top of a MacBook Pro’s keyboard. It was touch
sensitive, and its functions changed according to what
you were doing on your Mac. Unfortunately it was too
touch sensitive. Users complained they kept activating
its functions accidentally, and few third-party apps
took advantage of it anyway. Thankfully, with the 2021
notebooks, it’s gone. Once again we have a row of
physical function keys, this time standard-sized not
half-sized. Touch ID is retained, though; you can still
unlock your Mac, buy from the App Store and enter
passwords with your fingerprint.

percent more air than the previous generation, even at lower fan speeds.
The thermal design enables the MacBook Pro to deliver sustained
performance while staying cool and quiet. And because of the efficiency
of Apple Silicon, the fans never even have to turn on for most tasks

users perform every day. The result? Even at peak processing power, the
notebooks stay cool and quiet.

As mentioned before, this has taken a minor toll on the size and
weight of the machines. The 14-inch model is half an inch deeper and
around a third of an inch wider than the 13-inch M1 model, and weighs
in at half a pound heavier. Compared to the last Intel 16-inch MacBook
Pro, the new one s 0.02 inches thicker and 0.4 |bs heavier (width and
depth are too close to mention). So the new thermal architecture and
connectivity options have hardly taken a devastating toll on the 2021
MacBook Pro’s portability, and the results are definitely worth it.

The Touch Bar is gone, and few will miss it.

www.pclpublications.com | 15
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Video editing on professional
package Final Cut Pro.

The Cheapest 14-Incher... (and what it lacks)

At £1,899, the cheaper of the two off-the-shelf 14-inch MacBook Pros looks Youcan of course, use the online store’s customisation options to-add

like a pretty good deal, especially when you consider that’s £500 less than sqme or all of these things, but if you boost all of them, yournotebook will cost
the more expensive model of a similar size. But beware; it makes significant _,.«“‘55 much as - and, in fact, be - the higher-end 14-inch MBP-anyway. Forour
compromises to reach this price point. # money, the more expensive of the two 14-inch models is werth the extra £500.

s Processor: Every other 2021 MacBook Pro with an'M1 Pro chip.effers
ten CPU cores and 16 GPU cores. The cheapest 14-inch model reduces
this to eight CPU cores and 14 GPU cores.

s Fast Charging: Other MacBook Pros in the 2021 range have a 96W USB-C
Power Adapter that can fill a flat battery up te/a 50 percent charge
in half an hour. The cheaper 14-inch model has a 67W USB-C Power
Adapter and lacks fast charging.

s Storage: The cheaper 14-inch model has a 512GB SSD, with the more
‘expensive version enjoying a 1FB drive.

® Photoshop Fle Edit Image Layer Type Sehect

S UINBNSSEIND I

Adobe Photoshop
getting the most from
the MacBook Pro’s
new capabilities.

HE0eES0RSaPBBDNOEWMBARE r
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Which Should | Get?

If you’re interested in a new MacBook Pro, you're probably wondering which model you should get. If you’re
on a budget the 13-inch MacBook Pro with an M1 chip, released last year, is still on sale but next to the M1 Pro

and M1 Max notebooks, itisn’t very pro any more. All models are available in Silver or Space Grey.

Apple’s Current MacBook Pro Range @

Apple’s Current MacBook Pro Range

l—

Tone. 2560x1600
native resolution at
227 pixels perinch

The MacBook Pros Price Screen Processor Memory Storage Connectivity

16-inch, 2021 £3,299/$3,499/3.849€ | 16.2inch Liquid M1 Max, 10-Core CPU, | 32GB Unified Memory | 1TB SSD Storage Three Thunderbolt
Retina XDR display. 32-Core GPU 4 ports, HDMI port,
3456-by-2234 native SDXC card slot,
resolution at 254 MagSafe 3 port
pixels perinch

16-inch, 2021 £2,599/$2,699/2.979€ | 16.2inch Liquid M1 Pro, 10-Core CPU, | 16GB Unified Memory | 1TB SSD Storage Three Thunderbolt
Retina XDR display. 16-Core GPU 4 ports, HDMI port,
3456-by-2234 native SDXC card slot,
resolution at 254 MagSafe 3 port
pixels perinch

16-inch, 2021 £2,399/5$2,499/2.749 € | 16.2inch Liquid M1 Pro, 10-Core CPU, | 16GB Unified Memory | 512GB SSD Three Thunderbolt
Retina XDR display. 16-Core GPU Storage 4 ports, HDMI port,
3456-by-2234 native SDXC card slot,
resolution at 254 MagSafe 3 port
pixels perinch

14-inch, 2021 £2,399/$2,499/2.749 € | 14.2-inch Liquid M1 Pro, 10-Core CPU, | 16GB Unified Memory | 1TB SSD Storage Three Thunderbolt
Retina XDR display. 16-Core GPU 4 ports, HDMI port,
3024-by-1964 native SDXC card slot,
resolution at 254 MagSafe 3 port
pixels perinch

14-inch, 2021 £1,899/51,999/2.249 € | 14.2-inch Liquid M1 Pro, 8-Core CPU, | 16GB Unified Memory | 512GB SSD Three Thunderbolt
Retina XDR display. 14-Core GPU Storage 4 ports, HDMI port,
3024-by-1964 native SDXC card slot,
resolution at 254 MagSafe 3 port
pixels perinch

13-inch, 2020 £1,499/51,499/1.679€ | 13-inch Retina Apple M1, 8-Core CPU | 8GB Unified memory | 512GB SSD Two Thunderbolt /
display with True and 8-Core GPU Storage USB 4 ports
Tone. 2560x1600
native resolution at
227 pixels perinch

13-inch, 2020 £1,299/51,299/1.449 € | 13-inch Retina Apple M1, 8-Core CPU | 8GB Unified memory | 256GB SSD Two Thunderbolt /
display with True and 8-Core GPU Storage USB 4 ports

www.pclpublications.com | 17
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~New Procéssors f |X ew Macs

\
Apple’s new MacBook Pros arefpowered by two new outstanding i

ilicon processars; the M1 Pro and M1 Max.

pple’s Mac range is a year into a two-year transition from Intel processors to the

company’s own Apple Silicon chips. Even before the October announcement, you
could buy a Mac mini, iMac, MacBook Air and a 13-inch MacBook Pro powered by the
first Apple Silicon processor, the M1 system-on-a-chip. Now Apple Silicon has found its
way into even more notebooks in the MacBook Pro range. Apple’s new 14-inch and 16-
inch high-end notebooks have two new Apple Silicon chips to power them; the Apple
Silicon M1 Pro and M1 Max.

The two new chips take the already-powerful Apple Silicon processor to a whole new
level. According to John Ternus, Apple’s Senior Vice President of Hardware Engineering,
“the M1 Pro is the first pro chip on a Mac”. It features scaled up architecture that allows it
even more power than the M1 processor, while retaining the advantages gleaned from
having the entire system on a single chip.

Traditional processor architecture has separate chips for the central processing unit (CPU)
and the graphics processing unit (GPU), each with their own memory allocation, which is
again on separate chips. This means they must copy data back and forth between them,
slowing down their overall speeds. It also demands a lot of power and cooling, With Apple
Silicon, all these elements are contained within a single chip, which makes for less data
shuffling, much faster computing speeds, lower power consumption and less demands on
the computer’s thermal system.

, JI‘u‘\L"" i

s

The new processors offer scaled-up versions of the M1’s architecture, allowing Apple to cram on even more transistors for increased power.

18 | www.pclpublications.com



The new M1 Pro
system on a chip.
I

Pro-level power

The M1 Pro benefits from the single-chip technology pioneered with the M1, and takes
them to the next level. It offers up to 200GB/s of memory bandwidth, the speed at
which data is transferred from the computer’s memory to its processor. This is almost
three times that of the original M1 chip. It supports up to 32GB of unified memory too,
where the 13-inch MacBook Pros with original M1 chips could only offer up to 16GB.

The M1 Pro features around 33.7 billion transistors, more than twice that of the M1,
and has a ten-core CPU; eight high-performance cores and two high efficiency cores,
delivering up to 70% faster CPU performance than the M1. For graphics, it has 16 GPU
cores, eight more than the M1, and doubles its GPU speed. You can hook your M1 Pro-
powered MacBook Pro to two external displays too.

The top-of-the-

To the Max...

For those who need even more processing power than the Apple Silicon M1 Pro can give,
there’s another new chip on offer; the M1 Max. “This incredible chip,” argues Johny Srouiji,
Apple’s Senior Vice President of Hardware Technologies, “builds on M1 Pro and takes
itsamazing capabilities to new heights.” Memory bandwidth is up again, offering up to
400GBY/s, which is twice as much as the M1 Pro and six times that of the original M1 chip.

The M1 Max can support up to 64GB unified memory. It has a staggering 57 billion
transistors, which is 1.7 times that of the M1 Pro and 3.5 times the original M1 chip. It has
the same ten-core CPU, but doubles the graphics cores to 32, making it up to four times
faster in terms of graphical performance than the M1. This is clearly a chip designed for
video editors and rendering professionals.

range M1 Max chip.

With an M1 Max, users can connect up to three Pro Display XDRs and a 4K TV, all at
the same time to create a truly awesome editing suite. Are you jealous yet?

‘ New Processors for New Macs

Charting Apple Silicon’s
Rapid Success

When comparing the CPU performance M1 Pro and

M1 Max to the latest PC laptop chips, we see they put
in a more powerful performance while consuming
considerably less power. Graphical power is also
considerable, especially with the M1 Max, which
comes close to top-of-the-range PC performance while
consuming a fraction of the power, and exceeds the
performance of compact PC notebooks, that is, those
of a similar form factor to the new MacBook Pros.

CPU performance vs. power

M1 Pro/ A1 Max

70% less power

GPU performance vs. power
100W less power

/ M1 Mo ////

/

/

e High-end PC
apiop grapiics

GPU performance vs. power

40% less power
1M

/

/

Hand in hand

The new chips - and indeed the original M1 - are designed to work
hand in hand with macOS, giving Apple Silicon-powered Macs a great
power performance and speed efficiency, at low power consumptions.

Every single Apple app is optimised for Apple Silicon processors
like the M1, M1 Pro and M1 Max. This includes Safari, Mail, Notes
and other applications that come bundled with macOS, but also
apps like Pages, Numbers and Keynote, which are downloaded
from the App Store for free, and pro-level software like Logic Pro and
Final Cut Pro. Third-party apps written for Intel processors but not
yet optimised for Apple Silicon run very well too, thanks to Apple’s
built-in Rosetta 2 software. You can even run iPad and iPhone
applications on Apple Silicon Macs.

For Mac owners, the future is certain. The future is Mac.
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ilhe Road to
lVionterey

From OS X Cheetah in 2001 to macOS Monterey 20 years later, the Mac’s
operating system has quite a history. Here’s how we got from there to here.

MgNs Nern 0

Version: Mac OS X 10.0
Codename: Cheetah
Date: March 24th, 2001

Steve Jobs famously said

“We made the buttons on the
screen look so good, you'll
want to lick them,” when
describing the new Aqua User
Interface with the release of
Mac OS X. While we may not
have licked them, they were
certainly new, fresh and good
to look at.

Version: Mac OS X 10.4
Codename: Tiger
Date: April 29th, 2005

One of our favourite new
versions of Mac OS X.
Tiger was a hefty release
with over 200 new features,
including Apple TV,
Spotlight and Dashboard.

20 | wwwpclpublications.com

Version: Mac OS X 10.1
Codename: Puma
Date: September 25th, 2001

Less of a functional

update with Puma and
more of a performance
enhancement. Puma
introduced better handling
of optical disc burning, file
management and improved
responsiveness throughout.

RO8 RS G OT, S

Version: Mac OS X 10.5
Codename: Leopard
Date: October 26th, 2007

Leopard was a long time
coming butwhen it did it
brought with it one of the most
impressive leaps in desktop
technology. Time Machine,
Boot Camp and full 64-bit
support were all introduced in
2007's OS.

Version: Mac OS X 10.2
Codename: Jaguar
Date: August 23rd, 2002

The release of Jaguar saw.
a new Apple logo (the large
grey version), better search
functionality and Universal
Access. iChat and the
Address Book were also
introduced with this version.

LAY\ CULL ot Y Tt

Version: Mac OS X 10.6
Codename: Snow Leopard
Date: August 28th, 2009

Another two years apart and
Snow Leopard brought us the
Mac App Store, 64-bit apps
and many more refinements
that made it an excellent
upgrade for those wanting
more from their Macs.

Version: Mac OS X 10.3
Codename: Panther
Date: October 24th, 2003

We saw Safari becoming

the default Internet browser
with the launch of Panther,
alongside Exposé and

some much-needed
performance enhancements.

MO BROOBO DT AT

Version: Mac OS X 10.7
Codename: Lion
Date: July 20th, 2011

Apple adopts this

whole cloud thing

back in 2011, with the
introduction of iCloud
alongside a number of
refinements, performance
enhancements and core
OS improvements.



[The Road to Monterey -

Version: Mac OS X 10.8
Codename: Mountain Lion
Date: July 25th, 2012

Despite the fact that the world
was setto end in 2012, it
didn' stop Apple from adding
a lot of enhancements to
2011’s Lion. This is one of

the first OS X versions to start
integrating iOS perks.

Version: Mac OS X 10.9
Codename: Mavericks
Date: October 22nd, 2013

The first OS X not to be
named after a big cat,
instead a surfing location in
North California, Mavericks
introduced Maps, iBooks
and iCloud Keychain
encryption technology.

Version: Mac OS X 10.10
Codename: Yosemite
Date: October 16th, 2014

YYosemite was an impressive
upgrade, with a new sleek look
and design that's paved the
way for better iOS and OS X
interaction —which culminates
eventually with Big Sur.

:»‘A
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Version: Mac OS X 10.11
Codename: El Capitan
Date: September 30th, 2015

There were various
improvements introduced with
El Capitan, including dual-
window functionality and Split
Views alongside an upgraded
Safari, Mail and other apps.

Version: macOS 10.12
Codename: Sierra
Date: September 20th, 2016

Many see Sierra as the
version that finally killed of OS
X, since the OS is no longer
referred to as Mac OS X and
is from this point on known as,
macQOS. Siri is introduced with
this version and support for
Apple Watch.

i

Version: macOS 11
Codename: Big Sur
Date: November 12th, 2020

Big Sur was the first operating
system written for the new
Apple Silicon processors,

as well as Intel chips. It

also featured a redesigned
Notification Centre and a new
Control Centre.

Desktops Credit: 512pixels.net

Version: macOS 10.13
Codename: High Sierra
Date: September 25th, 2017
High Sierra was more of a
performance improvement
rather than an upheaval of
the apps. The main reason for
the increase in speed in the
OS is down to the use of the
Apple Fie System and video
standard HEVC.

Version: macOS 10.14
Codename: Mojave

Date: September 24th, 2018
Dark Mode and Dynamic
Desktop were the two main
updates on everyone’s lips
with the release of Mojave.
Visual improvements aside,
we also see some iOS apps
being migrated across in the
form of News, Home, Voice
Memos and more.

Version: macOS 12
Codename: Monterey
Date: Autumn, 2021

macOS Monterey introduced
Shortcuts for the Mac, as well as
Quick Notes, Live Text and more.
The Safari app was completely
overhauled, and new features
were added to FaceTime.

Version: macOS 10.15
Codename: Catalina
Date: October 7th, 2019

Catalina put the cat among the
pigeons, with Apple dropping
32-bit apps. However, the
move proved to be a good
one in the long run, with better
performance throughout.
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An Introduction to
macOS Monterey

macOS Monterey is the latest release of

Apple’s Mac operating system, and it
boasts some great new features. Let’s take
a look at what Monterey can do for us, and
why we should be excited about it.

BO*=50a

The new features associated with Apple’s iCloud+ service are available across all
your Apple devices, including Macs running the new macOS Monterey.

iCloud+

iCloud+ is a new service covering our Macs and mobile devices.
Previously, the only benefit in subscribing to iCloud as opposed to
enjoying the free 5GB of storage you get for free is the greater
capacity it offers. But Monterey introduces iCloud+, free features for
those who pay for iCloud.

How many times have you wanted to enter an online competition,
but didn’'t do so because you feared getting endless spam emails
afterwards? With Hide My Email you can create a randomly generated
email address that's unique to you. Emails sent to this address are
automatically forwarded to your own address. So if you enter that
competition and win, you get the message. If they send unwanted
adverts, you can disable the Hide My Email address you used, so the
spam no longer reaches your inbox.

Shortcuts

Shortcuts was already a big feature on the
iPhone and iPad, and with Monterey it
arrived on the Mac. Shortcuts helps you
automate everyday tasks. Open the
Shortcuts app and you can use a huge
range of pre-built actions designed just for
Mac to build routines to carry out all sorts
of tasks. You can make shortcuts to
instantly share files, make animated GIFs,
and so much more too. You can activate a
shortcut from the Mac’s menu bar, or by
asking Siri to do it. You can even import
existing Automator workflows into Shortcuts
and be up and running right away.

Not everyone will bother with Shortcuts,
but if you take time to write some decent
routines that fit the way you use your Mac,
it's a rewarding and useful tool.

MBEO*=30a @8-~ '080B+0 - a¥

Other iCloud+ features include iCloud Private Relay and expanded —
HomeKit Secure Video support, which lets you upload even more

Shortcuts is coming to the Mac with macOS Monterey.

footage from security cameras to your cloud storage.
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Quick Note

Notes is a hugely popular app. It's a great way of keeping

your jottings handy, and always on your person. You might

forget to carry a notebook with you, or leave a scrap of paper -

in your trouser pocket and wreck it in the wash, but you never

leave home without your phone, right? With Monterey, Notes s

got a great new feature — Quick Note —which lets you jot K ) p i

down anything you like, from anywhere on your Mac. e ) t u
Whichever app you're working on, you can open a Quick

Note and jot something down. You can copy and paste text

into a Quick Note, add web links and more, and in compatible

apps you can even add a link to a Quick Note, so it appears

when you open the app or document you were working on ® on

when you made the note. Your Quick Notes can be found in o M P _ Mirech 1

the Notes app, and are synced in Notes on your iPhone and

iPad too. PO =30"a @8- - o0EG0B+0 oW
Quick Note is a feature that will show its strengths MacBook Pro

over time, but even after a couple of weeks it's proving <

useful. After a couple of months with Monterey, when

you've got into the habit of using it, Quick Note should Make a Quick Note from anywhere on your Mac, and review it in the Notes app.

prove invaluable.

@ Notes Fio Edn Fomst View Window Help

Listen Now

Y%

Also on iPhone and iPad.

macOS Monterey also brings to the Mac some great features that are shared
with iOS and iPadOS.

The FaceTime app gets SharePlay, a feature that lets you chat to friends and
family while you all listen to the same music or watch the same movie or TV
show, with your media playing in sync. It's a great way to have a film evening
without being in the same house. Spacial Audio means during FaceTime group
conversations, the sound comes from the direction of the person who's speaking,
making conversations more natural, and you can choose a Mic Mode that cuts
ambient noise or lets it in, depending on your needs. You can have a group chat
using a grid view and schedule a chat with Calendar events too.

In the Messages app, the Shared with You feature makes it easy to find media
that’s been shared in Message chats in their native apps. These are offered in
Shared with You sections in Podcasts, Photos, Apple News, Safari and more.

Talking of Safari, it's had a major overhaul on the Mac and Apple mobile
devices, making it much more intuitive to use. If you open a lot of tabs, you'll love
Tab Groups, for example. =

You can design your own Do Not Disturb setups using the Focus feature, and Req U | re me ntS.
Universal Control lets you use your Mac and iPad in unison, using your Mac’s
keyboard and mouse/trackpad. It's all in macOS Monterey.unique to the Mac. All Apple Silicon Macs and the following

Intel Macs can run Monterey.

Desktops

— * iMac late 2015 and later
«mfnm 10:41 40 * iMac Pro 2017 and later

& DoNotDisturb *  Mac mini late 2014 and later

-] =
[=2) Coding B
3D SolarSystem ) M Shared Components ) B) Seenes i ’ e * Mac Pro late 2013 and later

rol  Window Help == = Q & MonJun7 9:41AM

System: Ready | Today at 9:41 AM

mms Evening

Until Tomorrow

Alna/z 0n Notebooks
® Gcaning Focus is an MacBook Air early 2015 and later
@ rorsora interesting MacBook Pro early 2015 and later
@ v new feature MacBook early 2016 and later

that’s available
across Apple to see more new features that are

devices. unique to the Mac.

-
Starts at 10:30 PM

Focus Preferences...

diameter + scaleFactor i (
(orbitalRadius « scaleFactor, (
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First Steps
with
MacBook

This section is designed for people who
are new to the MacBook, or intermediate
users who would like to know more
about its features such as Widgets,
Finder, Menus, Gestures, Dock and
more. If you haven't yet set up your
MacBook, there’s a guide to getting
started straight out of the box, and when
you're ready to install more apps, you
can learn how to do that too.

Learn more >



1 First Steps with MacBook ’

= Set Up Your Mac
=" Forthe First Time

If you have a new Mac but have not yet set it up, follow this guide. It's nothing

to be afraid of; follow the guide and the on-screen instructions, and step by
step, you get to set your Mac’s language, take it onto the Internet with your
local Wi-Fi network, sign in with your all-important Apple ID and more.

1 Your first step is to choose your territory, that is, where
you live and will be using your Mac. You can scroll the
list of countries up and down to find your own, or start to type
it to get there quicker. Click your country to highlight your
choice, then click Continue.

Accessibility

oo you

now
finish setting u it nom»s-m mner smmv e s Wik s Rl ¥ et

3 If you have a disability that makes it harder to use a
computer, the Mac’s Accessibility tools could be of
interest. If you want to set up your Accessibility settings
now, click one of the buttons. If not, click Not Now — you can
do it later in Settings.

Written and Spoken Languages

‘The following languages are commonly us sel
up your Mac o use these settings or ¢ Cuiones them i -

Preferred Languages
English (UK)

ot Surces
o

(), Dietation
& Engiish (United Kingdom)

Now select your language and input source. The

default ones for your chosen territory are offered, but
if you want to change them, click Customise Settings and
set the language your Mac uses and the keyboard layout to
suit your specific needs.

How Do You Connect?

Select how your computer connects to the Internet.

O Local network (Ethernet)

My computer does not connect 1o the Internet

Back  Continue

Choose how you want to connect to the Internet. If you

use Ethernet, there’s nothing else to do, but if you use
Wi-Fi, you then need to follow the on-screen instructions on
finding your own network and entering your password. Keep
your router instructions handy.
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Data & Privacy

This icon appears when an Apple feature asks to use your personal
information.

You won't see his infor
3 or personalise

your experience.

Apple believes privacy s a fundamental human right, 5o every Apple

to minimise d use of your data, use
on-device processing whenever possible, and provide transparency and
control over your information.

Learn More.

Back  Continue

Next comes the Data & Privacy screen. You're shown

an icon that appears when an Apple feature collects
information, and needs your permission. There’s nothing you
need to do on this screen, just read it for reference and
move on once more.

.'I\ﬂ ’@g

Sign In with Your Apple ID

Sign in to use iCloud, the App Store and other Apple services

] E—

Create new Apple ID.
Forgot Apple ID or password?

Use different Apple IDs for iCloud and Apple media purchases?

Set Up Later

7 Now it's time to sign in with your Apple ID. If you
already have an Apple ID, sign in now with your
password. If you don't, click the Create New Apple ID link
and follow the on-screen instructions. There’s also a link for if
you've forgotten your Apple ID.

Terms and Conditions

Important: Use of your

. the related tothese
Terms and Conditions. Please read them carefully.

A Software Licence Agreement

& AGREEENT

Mac, The Licence is aso posted at www.apple.comjuklegalisa

Back  Agree

You're shown a screen of Terms and Conditions,

which you can read by scrolling if you wish. When
you're ready, click the checkbox labelled ‘I have read and
agreed to the iCloud terms and conditions’, then click the
Agree button in the bottom-right.

[ Set Up Your Mac

V)

Migration Assistant

M you have i her Mac or a Windows PC, transfer It to this Mac. You can also
transter information from a Time Machine backup or anather startup disk.

How do you want to transfer your information?

© From a Mac, Time Machine backup or Startup disk
From a Windows PC

Back  Continue

You're invited to transfer information from a Mac or Time

Machine backup, a Windows PC or not at all. To transfer
data from your old computer, choose the correct option and
follow the on screen instructions. Otherwise, choose the last
option to start afresh.

.‘Aﬂ ’@'_3

Sign In with Your Apple ID

Sign in 10 use iCloud, the App Store and other Apple services.

A message with a verification code has been sent to your other devices running (05 10 or
MacOS Sierra o later. Please enter the code to continue.

UUCIDC]

Set Up Later

If you already have an Apple device, a pop-up window

appears asking you to allow the new log-in. Do so, and a
six-figure number is sent, which you must type now. If it doesn't
arrive, click the link under the number fields and follow the
instructions. Otherwise, type the numbers and proceed.

Create a Computer Account

Fillout to create your comp

Back  Continue

T Your account name is based on your Apple ID name but
your password, which unlocks the computer, should be
chosen now. Choose something you can remember and enter
a hint in case you forget. Click the small picture to choose a
different one, or take a photo using the Mac’s camera.
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O

Satting Up Account.

11 The Mac now sets up your iCloud account on your

computer. This is the screen you see while it's working
things out. You don't have to do anything; just sit and wait. It
takes just a few minutes, so don't assume it's got stuck and
try to interrupt or restart it.

Analytics
Helo Apple and app developers mprove thek products and services automatically.

To haip Appie Improve s products and services, pre-release beta
vor 08 data

About Analytics & Privacy.

13 You can now choose whether you allow analytic

information to be sent to Apple and/or third-party
software developers so they can improve their products. If
you're concerned about privacy, you can decline, but it's
helpful if you agree to share.

Choose Your Look

Select an appearance and see how the Dock, menus, buttons and windows adjust depending on which

You can change this later in System Preferences.

N

Light Dark

15 Choose how your Mac will look when in use. You can go for
the default light look, with white as the predominant

background colour, or dark, with black backgrounds. Auto

switches between light and dark depending on the ambient light.

Make This Your New Mac
Here's everything set up 5 you had It on your other Mac.

Learn More.
Location Services

Allow Maps 3nd other ag
a Device Analytics

Help Apple impro

[ o e Anslytion

nsu

12 On the Make This Your Mac screen, you can set up

your Mac quickly, by allowing predetermined settings
to take effect, for things like Siri and Maps. You can
customise these settings by clicking the link; we suggest
you just click Continue instead.

Screen Time

Get insights about your screen time and set limits for what you want to
manage.

14 You now decide whether or not you want to set up

Screen Time. Click Continue to have Screen Time give
you updates on how you're using your Mac, or the Set Up
Later link at the top to leave it be for now. You can activate it
later in System Preferences.

Amar Yapp

16 Your Mac then sets up, and launches into the lock screen.

Type the password you set up earlier, and your Mac and
Big Sur are ready to use. Congratulations, you've successfully
set up your Mac. We hope you enjoy using it.




Changing Options After Setup
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System Preferences
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1 You can change some of the choices you made while
setting up your Mac by going into the System
Preferences; you can find this in the Apple menu, in the
top-left corner of the screen. There's a number of settings
you can change in this way.

Reset to Factory Conditions.

[ Set Up Your Mac | @8

To change the Analytics option, use the Security &
Privacy pane. Click Privacy and select Analytics &
Improvements to access your options. Other preference panes
that let you change options you previously set up include;
Language & Region, Accessibility and the General pane.

If you acquired your Mac second hand, you might want to wipe it clean and start again. Just follow this guide.

Pt b Thv Machon
@ PO ——
;—:! b

o Disk Utility

First, restart your Mac whilst holding down cmd-Shift-Alt-R; keep

them held until you see the Apple logo, then let go of the keys.

The Mac continues to boot, but instead of the regular desktop, a

window appears showing four options as seen here.

On the next screen, the Format pull-down menu should read
APFS if it's available or Mac OS Extended (Journaled) if it isn’t.
Select the appropriate option and click Erase to wipe your boot
drive. When it’s finished, click Done, then quit Disk Utility (cmd-Q).

From the window, select Disk Utility (the bottom of the four
options) and click Continue. Select your startup disk (called
Macintosh HD by default) and in the toolbar at the top of the
Disk Utilities window, click the Erase icon to wipe it clean.

macOS Monterey beta

To set up tha installation of macOS Montarey beta, click Continue.

Continwe

Now choose to install macOS and continue. When invited to install
the operating system, do so; you might have to click on the Wi-Fi
icon in the menu bar and rejoin your wireless network. Agree to
T&Cs, select your main drive and click Install to start afresh.

www.pclpublications.com | 29



] First Steps with MacBook ’

72\ Using Touch ID
(’@@\’ On the Latest Macs

Touch ID has long been a stalwart on the iPhone and iPad, but it recently
came to the Mac, with the latest notebook and iMac releases; look for a Touch
ID sensor on the keyboard. You can use Touch ID to unlock your Mac, input
passwords and make purchases, all by using your fingerprint.

Setting Up Touch ID

L] < i System Preferences

lan Osborne
Apple 1D, Cloud, Media & Asp Store

i Touch ID

Touch ID lets you use your fingerprint to unlock your Mac and make
purchases with Apple Pay, iTunes Store, App Store and Apple Books.

=

= - (S

Finger 1 Add Fingerprint

Use Touch ID for:
Unlocking your Mac

@ Apple Pay

iTunes Store, App Store & Apple Books
Password AutoFill

Use Touch ID sensor for fast user switching

1 First of all, open the System Preferences window. Click If your Mac does have Touch ID, to get started, click on
on Touch ID. If this option isn’t there, your Mac doesn't the + icon captioned Add Fingerprint’. You can add
have Touch ID as it's a feature on newer Macs. more than one print; here, this is our second.
— B - SS—
L] < i Touch ID Q o < i Touch ID Q

Place Your Finger m Place Your Finger
Lift and rest your finger on Touch ID repeatedy. / /} | Lift and rest your finger on Touch ID repeatedly.

Type your admin password when asked, the one you use Keep raising and lifting your finger. As you can see, the

to unlock your Mac. As instructed, you must now place grey fingerprint in the window gradually turns red, as
the finger you intend to register on the Touch ID sensor, on the Touch ID reads, analyses and records your fingerprint. Keep
top-right of the keyboard. doing this until the centre section is full.



L] < i Touch ID Q
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Cancel

Touch ID now needs to cover the edges of your finger.
Continue liting and placing your finger, but concentrate
on having the edges of that fingerprint on the Touch ID sensor.

L] < i Touch ID Q

Touch ID is Ready

Your fingerprint can be used to unlock your Mac.

7

i

17
\

1
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S=77y
S=——-~
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The edges gradually build up and go red. Eventually, all

the fingerprint area in the window is red, and you're
told that the registration is complete. Click the Done button in
the bottom-right corner to finish.

° < # Touch ID Q

‘Touch ID lets you use your fingerprint to unlock your Mac and make
purchases with Apple Pay, iTunes Store, App Store and Apple Books.

-

Finger 1 Finger 2 Add Fingerprint

Use Touch ID for:

Unlocking your Mac

Apple Pay

@ iTunes Store, App Store & Apple Books.
Password AutoFill

Use Touch ID sensor for fast user switching

7 There’s a list of things you can do with your Touch 1D
instead of typing your admin password. Take a look and
uncheck any that you don't wish to use.

| Using Touch ID |1

Using Touch ID.

lan Osborne

Unlocking Your Mac

With Touch ID, you can place your finger on the sensor to
unlock your Mac, without your admin password. You still
need the password after it restarts.

Making Purchases

You can use your Touch ID to make App Store purchases.
Buy an app in the usual way, and instead of typing a
password to complete the purchase, use Touch ID.

® @ ® & Q 8 © MonaOct 11
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Amar Yapp  lan Osborne

Login Window...

Users & Groups Preferences...

Fast User Switching

If two people have accounts on your Mac, and you’ve enabled
Fast User Switching from the menu bar, you can use your
Touch ID to switch between users too.
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Welcome to the
Monterey Desktop

The desktop is at the heart of your Mac. Everything you do takes place on the
desktop, including opening apps, interacting with files and folders and using the
Dock. Here we show you how to use your desktop, app and folder windows,
the top bar menu and other key features.

From the Apple menu you

can log out, shut down,
restart or put the computer into
sleep mode, get comprehensive
information on the computer’s
hardware and software, access the
System Preferences and open
items you've recently closed.

The menu bar running along

the top of the desktop gives
access to functions and controls for
the app you currently have open at
the time. The app currently in use is
shown to the right of the Apple icon.
In this case it's Finder. Open or click
on an app and its hame is shown
here instead; and its menus are
listed in the menu bar.

The Command Centre is where

you can access Bluetooth,
Wi-Fi settings, display brightness,
volume, keyboard brightness, Screen
Mirroring and much more.

Application windows come in

all shapes, sizes and designs.
Your Mac’s applications can be
launched from the Launchpad, the
Dock, from Spotlight or using
Applications window in Finder.

This is a Finder Window. The

Finder utility is the central
point for navigation and file
manipulation. You can browse and
navigate applications, documents,
external drives and even access
other computers; as long as they're
connected to the same network
(cabled or wireless).

This is your Mac’s Desktop.

Click on it to access the
Finder controls in the menu bar.
You can change the picture (or
wallpaper) used for the Desktop in
System Preferences > Desktop &
Screen Saver. ‘The one we have
here is the standard macOS
Monterey desktop, but there are
plenty of others to choose from,
including wallpapers from older
versions of macOS.

7 In macQS, folders work just
like their real-world
counterparts. You can use them to
store files, data and even other
folders. You can call them anything
you like; click on a folder’'s name and
type in a new one.

The Dock offers quick and

easy access to your favourite
applications, documents, folders
and even the Bin. It's easily edited
and customised to make the most
of the way you work. Apps you
currently have open are always
shown in the Dock.

You can also put folders in the

Dock, as shown here. Click on
a folder to open it within the dock,
and then click on something inside
the folder to open or launch it.

The Bin, formerly called the

Trash. To delete a file, folder or
application, drag it into here, then
right-click on it and choose ‘Empty
Trash’ from the menu.

@ [Finder File Edit View Go

Window Help

About This Mac

System Preferences...
App Store...

Recent ltems >

Force Quit Finder Xo8d =

Sleep e

Restart... =
Shut Down... &

4¥Q

Lock Screen
Log Out lan Osborne...

Favourites
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= =
Siri.
Some things you can

Siri is Apple’s askme:
personal digital
assistant and you can
use it on your Mac.
Just click on this icon
and a Siri window
opens. See the Siri
tutorial for more
information on how to
use this feature.

r
my Downloads folder”

‘ The Monterey Desktop -

Date, Time,
Notifications &
Widgets.

Click on the time here and to open

the Notifications and Widgets
sidebar. If you go into System
Preferences > Dock & Menu Bar
and click the Clock option in the
sidebar, you can set how the date
and time are displayed here.
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1 First Steps with MacBook ’

Customising the
Monterey Desktop

Although macOS Monterey’s default desktop image is very attractive, if you'd
prefer something different, you can personalise your experience by customising
the appearance of your Monterey Desktop. You can choose a new wallpaper
for the desktop image, and even set up a slideshow of your favourite pictures.

Choose New Wallpaper

& Systemprefersnces £t View Window Hep

©0 t1 Qs 7~ @ & & O museion

@ © + Q® = W & & O Fizase )

e

ma\ral Desktop & Do
e s Screen Saver Mg,

i
)

®

1 To open the Desktop preferences window, click the Click on the image you'd like to use for your wallpaper. If
Apple menu, select System Preferences and select the there’s a cloud in the corner, click on it first to download
Desktop & Screen Saver option. Select the genre of picture the image. The desktop is updated immediately. Keep it or
required from the left column. choose another one.

Use an Image from Your Photos Library.

& System proferences _Ean Virdon Yo © O % QS * W L & O Fase oskem

Desktop  Sereen Saver

AAAAAAAAA

.......
aaaaaa

© Favourites
3 > (@ People
“\ > 4_) Shared

) Albums

Open the desktop preferences: Apple menu > System Explore your photo images, and then choose one from the
Preferences > Desktop & Screen Saver. Select the Photos right-hand panel. If it has a cloud in the corner, click this first
item in the directory list, click the chevron to its left to open to download the photo from iCloud. The photo is then used
it. Various options are available. for the desktop. Keep it or choose again.



Add a Folder to Folders List

i Desktop & Screen Saver

Dasktop  Screen Saver

macOS Graphic

Automatic e

1 Open System Preferences and click on the Desktop &
Screen Saver preference pane. In the left-hand column,
click the chevron next to Folders to see what folders are
currently listed in this option.

[ Customising the Monterey Desktop

Auto-changing WaIIpaper

il Desktop & Screen Saver

Deskiop  Screen Saver

Mountaincering 05

Fil Screen a

If you're using an image from a folder of pictures, you can
have it change automatically after a period of time. Set your
desktop from an image from that folder, then check the
Change Picture box.

R N TR

Click the *+ icon below the directory list to display a Finder

window. Navigate to a folder on your Mac that contains
pictures you'd like to use for deskiop images, select it and then
press the Choose button.

ystomPreforonces  Eot  View Window  Help. @ © t ae T m L & O anns-n]

. < il Desktop & Screen Saver 3 I
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When logging in
When waking from sicep

o
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With the box checked, the pull-down next to Change Picture
becomes available. You can choose when to have the
wallpaper change to a different picture from the folder;
displayed in order.

3 The required folder should now be visible in the Folders
section of the directory list. Click on it and you can
choose pictures in that folder as desktop images. Click on one

to set it as your wallpaper.

If you'd prefer the pictures were used in a random order,
check the box at the foot of the screen. The pull-down
above the pictures lets you choose how the images will fill
the desktop space.
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_} * Gesture Controls
» On Your Trackpad

You can navigate your Mac using gesture controls, just like you do on

your iPhone or iPad. These gesture controls can be performed on a Mac
notebook’s trackpad or on the Apple Magic Trackpad, which is available for
desktop Macs. You can even do a few of them on a Magic Mouse.

One of the things that makes the Mac such a pleasure to use is its large and responsive MacBook multi-touch
trackpad or the desktop Mac’s Magic Trackpad. You can use the trackpad in much the same way as you would use
the touchscreen of an iPhone or iPad: to quickly and easily access menus, sort through stacks of pictures or
documents, scroll through documents and to zoom in and out of displayed images. Once you get used to it, you'll find
that it's a very easy and intuitive way of controlling your Mac and that it can do far more than just scrolling.

Secondary Clicking.

Some people like to use a two-button
mouse with their Mac, and this can be handy
for quick access to shortcut menus by
secondary clicking or right-clicking. To set up
two-finger secondary clicking using the
trackpad, select Secondary Click in the Point &
Click pane of Trackpad preferences. To set up
a one finger secondary click zone in the
bottom left or right corner of the trackpad or
mouse, select Secondary Click in the Point & . .
Click pane of Trackpad preferences, and choose Smgle Click
an option from the pop-up menu. Unlike most other trackpads, the entire MacBook trackpad
works the same as the mouse button; and you can click
anywhere on the track pad to activate apps and select icons.

Multi-touch Gestures.

The MacBook’s advanced trackpad supports the
Multi-touch gestures. They might seem a bit complicated at [ [ [ o] ] 7

first but once you get used to them and have had a bit of . . ’ - _ n = - .
time to practise, they quickly become second nature. Before
long you'll wonder how you ever managed without them.
The trick to using the trackpad properly is to practise using
more than one finger at once. Some gestures use two
fingers, whilst others use three. You need to apply light, firm
pressure and move your fingers smoothly and evenly, all at
the same time. Like we said, it takes a little practice but you
quickly become proficient at it. To enable Multi-touch Scroll Vertically

gestures, view instructional videos of the gestures and set
up various other trackpad options, choose Apple > System
Preferences and then click Trackpad.

Place two fingers together on the trackpad, then move them up
or down. This will scroll vertically up or down the document or
web page you're currently viewing.

36 | www.pclpublications.com
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‘ Gesture Controls

Zoom In and Out

Two-finger pinching lets you zoom in or out on PDFs, images,
photos, and other large visual documents or web pages. Place
two fingers on the trackpad, then move them apart to zoom in,

or together to zoom out. The quicker you move your fingers, the

more you'll zoom.

S X
4 5 6 9

L
|

Rotating Images

You can rotate images by placing two fingers on the trackpad
and then turning your hand so that your fingers both move in a
curve. It can be a little awkward on the wrist at first but you'll
soon get used to it. With practice, you wonder how you ever
did without it.

Access Mission Control

You can access the macOS Mission Control at any time, even
if you've got a full-screen app open. Simply place three fingers
at the bottom of the trackpad and move them quickly upwards
and Mission Control appears.

Switching Between Full-screen Apps

If you've got several apps open full screen at once, you can
quickly flip between them using a gesture. Place three fingers
on the trackpad and quickly slide them to the left or right. This
will scoot the current app aside, revealing the next in line.

Force Click

The very latest Apple notebooks feature Force Touch
trackpads, which can tell a soft tap from a hard tap. A hard
tap, or Force Click, can be used to preview a file, drop a pin
in Maps, preview a Safari link, rename a file or folder and
more. It's a concept that should prove very familiar to those
who have used the latest iPhone models.

& System Preferences EGt Vew Window Help ©® 0 $+ QST W L 8O Musw

Turn Off Force Click

If you dislike the Force Click gesture, and find it gets in the
way of your workflow, it’s easy to turn it off. Open System
Preferences (under the Apple menu in the top left corner),
and go to the Trackpad pane. Under the first tab, Point &
Click, you see a checkbox labelled ‘Force Click and haptic
feedback’. Uncheck it to turn off this feature.
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=" Dark Mode
<o ANd Night Shift

If your screen’s too bright, there’s a couple of great desktop features that
help. Dark Mode inverts the Mac’s colour scheme, making it much darker,
and Night Shift Mode changes the colour hue, reducing blue light that can
keep you awake if you use your Mac before going to bed.

Dark Mode Night Shift Mode

Displays

Night Shift automatically shifts the colours of your display to the

¥
warmer end of the colour spectrum after dark. This may help you
| getabetter ight's sieep.
| Schedule:  Off e
|
Manual:  Turn On Until Tomorrow [iness
Colour Temperature:
s Loss war ore var
I

shin.  ?

1 From the Apple menu, open System Preferences. Click 1 From the Apple menu, open System Preferences. Click
on the General pane in the top left corner of the window. on the Displays pane and then on the Night Shift button.
At the top, under ‘Appearance’, are the Light, Dark, and Auto From here you can schedule Night Shift Mode to run from
buttons. Dark and Light buttons switch to those modes, and sunrise to sunset or during custom times; or you can simply
Auto lets you schedule the changes. turn it on by checking the Manual box.

With Dark Mode on, the colours are subdued in Finder, With Night Shift Mode enabled, the colour spectrum

windows, the Mac's built-in apps and more. shifts from blue to yellow. If you use your Mac late at
Third-party apps can be updated to take advantage of Dark  night, too much blue light can interfere with sleep patterns,
Mode too. If you find it more comfortable to work on a dark so using Night Shift Mode when on your Mac close to
screen, this is excellent news. bedtime can prevent this.




‘ Dark Mode & Desktop Stacks

Desktop Stacks
For Organisation

If your Mac’s desktop regularly gets cluttered with folders, file icons and other
such material that you're currently working on, there’s a solution at hand in
macOS. With a click of your mouse or trackpad, you can organise them into
stacks, grouped according to their file type. Here’s how to do it.

@0 1 Q% = @ & & O wmmne

1 Your Mac’s desktop often fills with files and folders you From the View menu, select the Use Stacks option.
know you need regularly but that can mean a very Your files are stacked on the right-hand side of your
cluttered workspace. To use Desktop Stacks, first click on desktop, according to their type. For example, images are
the desktop to make sure Finder is active, then click on the stacked together, as are documents. To turn this off again go
View menu in the top bar. to View and click Use Stacks.

® D % Q& T w & 2 O Sat20ct 1204pm

3 To open a stack on your desktop, click on it. The items You can choose how you group your stacks. In View,
contained in that stack are revealed, allowing you to go to Group Stacks By and then pick an option. If you
access and open individual files. To close a stack again, use finder tags (see later in this book) to identify files from
click on the down-pointing triangle icon that replaced the the same project, for example, grouping by Tags keeps
stack when you clicked to open it. them together and easier to find.
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D

, Getting Online
X With Wi-Fi or Ethemet

As is the case with any modem operating system, access to the Intemetis a
vital component for upgrading and getting hold of new apps that will help you
get the most from your Mac. Getting online in Monterey is remarkably easy and
here’s how to do it both wirelessly and with a cabled connection.

Connecting with Wi-Fi

O 32 Q () m & 8 ©

Make sure that your Mac is within range of your wireless

router’'s Wi-Fi signal, then click on the Wi-Fi icon in the
top menu bar. You'll see a list of Wi-Fi networks. If your Wi-Fi is
off click the switch to turn it on.

®@ © 3 Q 8 F ®wy KL & O Fi2asep 11:52am

| WA ( @)

Personal Hotspot
@ iPhone (2) il 4G =)
Other Networks

= House_of_Felix
+ SKYNFUPA
= smiths1

= smiths1_EXT
= Virgin Media

VM1842494

A The Wi-Fi network “House_of_Felix" requires a
= WPA2 password.
A 4 You can also access this Wi-Fi network by sharing the
password from a nearby iPhone, iPad or Mac that has
connected to this network and has you in their contacts.

Password: [sesesesevsvsnses

Show password
Remember this network

3 If a password is required (it probably is), a window
appears. Enter the password here. If you're setting up at
home, the password is probably supplied with your router. Your
Mac then joins the network, and remembers it so you don't have
to add the password every time you go online.

=
2 VM3935139
=

P P P P P P P DB <

'~ VM7625092
Other...

You'll see a list of Wi-Fi networks available in your area.

A lock to the right shows a password is required to join
it. Click on the network you wish to join, whether it's your own
router or a public Wi-Fi in a cafe or bar.

Using Public
Wi-Fi.

Some high street locations
such as libraries, bars and
restaurants offer free Wi-Fi
to their customers. There
are many different ways you
can access public Wi-Fi.
Some locations may have
an unsecured connection,
some require you to ask for
their Wi-Fi password, and
for others you have to register via their pop-up website;
just open Safari while in such a Wi-Fi zone and then
follow the on-screen instructions that appear when your
Mac connects to the network.




Configuring Your Wi-Fi

@0 tasamgeon

& Finder Fle Edit View Go Window Help

.......

Locaton:

1 Click on the Wi-Fi icon in the top bar, and in the menu
that is shown, click Network Preferences at the bottom.
The System Preferences window appears, with Network
Preferences already open. Click the Advanced button.

® 0 3 Qs  m L

= Wi

WiFi TCPIP DNS WINS 8021X Prodes Harcware

Prefacrad Networks:

Securty
WPAWPA2 Personal

You can see a list of all the Wi-Fi networks your Mac

has connected to, in order of preference. Where two
networks are available, the higher one is used. If you want to
change this order, simply drag and drop them.

System Preferonces Edit View Window el ©@ O taAaS T QRO

Network

WiFi TCPIP  ONS  WINS  8021X Prodes  Hardware

Configure 1Pva: _ Using DHCP a

1Pv4 Address: 192.168.178.22 Renew DHCP Lease

Subnet Mask: 256.255.266.0 DHCP Cllent I0:

Router: 192.168.178.1

Configure 1Pv6: ~ Automatically ]

3 In the TCP/IP tab, you're able to see what IP address
your Wi-Fi router has allocated to your Mac; handy if you
ever need to connect remotely from another computer. You can
also edit these settings and create your own, static IP address.

| Getting Online

Going Online with Ethernet.

If you prefer the stabi

lity and speed offered by a

cabled, Ethernet connection, here’s how to set this up.

Once you've set up your router according to the instructions
supplied with the device, getting online using Ethernet is
relatively easy. First of all, you need a cable that looks like

this. There should be at

least one supplied with your router.

LTS
3‘ N

Plug one end of the cable into your Mac and the other end
into one of the router’s Ethernet ports: it doesn’t matter which
one. If your Mac doesn't have an Ethernet port, you need an
adapter. You can get one online or from an Apple Store.

If your router isn't close
enough to your Mac to
support a cabled
connection, consider
using Home Plug AV
instead. This uses your
household electrical
wiring to send data.
Ask at your local
computer store about a
Home Plug AV starter
kit. There are many
different brands of
HomePlug AV devices
to choose from, and as
HomePlug AV is an
industry standard,
they’re all compatible
with each other.
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Monterey’s Menus
A Key Mac Feature

Whether it's a pull-down menu accessed by clicking on the top bar of your
desktop or a contextual menu found by right-clicking or ctrl-clicking on a
file or folder, you need to know how to use your menus if you are to get the
most out of your Mac and Monterey. Here’s a guide to your Mac’s menus.

The Apple Menu

The Apple menu is

found in the top left
corner of the desktop. To
open it, click on the Apple
icon once, then choose an
option. It's always there,
whatever it is that you're
doing on your Mac.

Finder File Edi

About This Mac shows

you technical information
about your computer. Tabs at
the top of this window let you
delve further, looking at its
Display, Storage and more; you
can get a full report by clicking
the System Report button.

Go Window Help

Show “App Store" in Finder m
.\ Show “FaceTime" in Finder

& Show “Finder" in Finder

5+ Show “Maps” in Finder
~ Show “Preview" in Finder
@ Show “Safari* in Finder
& Show “Secrets" in Finder

PD . DDDDD

130803880

The System

Preferences option
opens the Mac’s System
Preferences, which we
discuss later in this book.

This option opens the
App Store. If updates

' Image from Photos Step 1 Guide” in Finder
A Folder Step 1 Guide” in Finder
Add a Folder Step 2 Guide" in Finder
-C ing Step 1 Guide” in Finder
ing Step 3 Guide” in Finder

 Step 1 Guide” in Finder
i Step 1 Guide” in Finder

are available for your Mac or
any of its apps.

Hover your pointer over

the Recent ltems option
to see the sub-menu showing
apps, documents and servers
you've recently used.

@ & & © Fri24Sep 12:28pm




Click here for the Force

Quit window. This
window lists all currently open
applications and notes if any
of them are unresponsive,
that is, they've crashed. You
can force a crashed app to
quit from here.

7 Click here to put your
Mac into Sleep Mode.
This saves energy and
password-protects your Mac
while you're away from your
keyboard for any time.

Click here to restart

your Mac. This is useful
if you've installed new
software or your Mac isn't
behaving as it should.

Click to shut down your
Mac, that is, switch it off.

Lock screen brings up

your password screen.
You have to enter your
password to continue to use
your Mac. It's useful if you're
leaving your Mac for a while.

Get Info

Rename

Compress “Mountaineering 02.jpg"
Duplicate

Make Alias

Quick Look

ineering M

.ipg

fount

oz

e Copy
I g Share >

o0 0000

ineering  Mount  Tags...
1P i
Quick Actions >

Send with Transfer (Team BDM)
3 send with Transfer (Personal)
Move to Dropbox (Team BDM)
{5 Move to Dropbox (Personal)

: 3
. i

Services >

Contextual Menu

M ™ oen g
Open With >

ineering w Mountaineering  Mountaineering
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‘ Monterey’s Menus

Click here to log

yourself out but not
shut down your Mac. This is
useful if you have more than
one user account on your
Mac. You can then log out so
another user can log in.

By hovering over the

Recent ltems option,
you get this sub-menu. This is
a list of the applications
you've recently used. Click on
one of them to open it again
rather than use the Dock.

These are the

documents you've
recently used. If you need to
open one again, this menu is a
quick and easy way to do so.

Servers you've recently

accessed on your
wireless or Ethernet network
appear here. To open one
again, simply click on it.

Click here to completely
clear the entire Recent
Items sub-menu.

Application Menus

Files and folders have a Contextual Menu that you can access
by right-clicking or ctrl-clicking on the item, or clicking with two
fingers on a trackpad. This menu gives a range of options,
which change according to what it was you clicked on. There’s
usually a Share and a Move to Bin option in there, and the Get
Info option brings up an information window.

Right-clicking and ctrl-clicking.

Each application has its own unique set of menus located next
to the Apple menu. They will change when an application is
active and will revert back to the Finder menu when no apps
are active. Each is clearly labelled to make it easier. We'll add
specific details for application menus when we look into the
applications themselves later.

Mac mice and trackpads only have one button, so how do you make a right-click? It’'s actually easier than you think.

AppleID, Cioud, Media & App Store

g lan Osborne -
4 L

NTFS for Msc

1 Your Magic Mouse or Trackpad doesn’t have two buttons,
but you can still secondary-click by holding the Control
(ctrl) key and clicking your mouse or trackpad. Alternatively,
enable right-clicking. Go to Apple menu > System Preferences
> Mouse/Trackpad, depending on which you're using.

Silent elicking
Force Click and haptic feedback

Clck then pr ik Look, Look o,
nd variable 5 ol —

Click the checkbox for Secondary Click. There are also

a few other options here such as click weighting. With
Secondary Click activated, clicking on the right side of a
Magic Mouse or with two fingers on a Magic Trackpad is the
equivalent of right-clicking on a two button mouse.
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. Using Finder
Files, Folders & Apps

Finder is the main app that underpins everything you do in macOS, so it's worth
taking the time to discover its features and functions. On these pages you'll

see how Finder works and how you can use the Finder window; including its
navigation controls, viewing tabs and more, to get the most from it.

Window Control Options: Use the gumdrops to
close or minimise the window or open it in full-screen
mode. We’'ll cover this on the next page.

Navigation Controls: The chevron buttons in the
top left corner of the window take you forwards or
backwards through your navigation history.

View Options: These four buttons let you set-up

how you view the files and folders in the Finder window;
whether as icons, a list, in columns or as a cover flow which
gives you a much larger visual preview.

L N Kingston 8GB

$ Setapp
@ Airbrop
@ Recents

A, Applications

Item Arrangement List: Click on the button shown
here to order the contents of the window; according to
date, alphabetically and more.

Share Button: The Share button is found in many
places throughout macOS. Here you can highlight a file
or folder and click the button to send it by email, AirDrop etc.

Tags Button: You can tag a file or folder to make it

easier to spot or group it with other documents and
folders. An item can have more than one tag. Click on a tag in
the sidebar to show items labelled with that particular tag.
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Using the Finder E-

- Perform Tasks and Search: The Perform Tasks File/Folder View: This shows the files and folders

icon enables you to perform certain tasks within the contained in the currently open folder. They're shown in

folder or highlighted file, such as create a New Folder, Move the format chosen in the View Options (see feature number 3).

to Bin, Duplicate and more. Next to this is the Search bar. If Here, as you can see, we've gone for the icon view.

you're looking for a specific item, type its name or contents

into the Search field and press Enter. Preview: This is a preview of the currently selected

file in the main window. It shows the title, file size and

Sidebar: There are various options on the Finder various details about it. There are also options at the foot of
window'’s sidebar. You can open specific folders like the Preview sidebar, such as rotating or marking up a

Documents or Downloads, access external or network drives  graphic or creating a PDF from a document. The preview
and more. To hide and show the sidebar, use the View menu  sidebar is optional but useful; you can close it in the View

to toggle it on or off or enter ctrl-cmd-S. menu or by pressing Shift-cmd-R

Displaying a Finder Window How to Relaunch Finder

There are several ways of opening a new Finder window If the Finder has crashed or isn’t behaving as it should,

on your Mac’s desktop. Let’s take a look at each in turn. follow this tip to close it like a crashed app and relaunch it.

@ Finder File Edit View Go Window Help @ Finder File Edit View Go Window Help

New Folder O8N
New Folder with Selection AN
New Smart Folder

New Tab ®T Recent Items

System Preferences...
App Store...

>

Open With >
Close Window rw Sleep
Restart...
Using Menus Shut Dowin...
Lock Screen ~RQ

Click a clear space on the desktop once, open the File menu

and select New Finder Window. A window then appears. w0

Shortcut Keys
Click a clear space on the desktop once to make sure
you're in Finder, then press cmd-N together. A new Finder If the Finder crashes, you can relaunch it like you would with any
window appears on the desktop. other crashed app. The easiest way to do this is to click on the

. desktop to make sure you're in Finder, hold down the Shift key
Using the Dock and click on the Apple menu. The Force Quit option has
If it isn’t already displayed, move your mouse cursor to the become Force Quit Finder. Incidentally, you can use this method
bottom of the screen to open the Dock. Click the Finder to quit any running app. Just click on one of its windows to bring
Window to create a new window. it to the fore, hold Shift and click on the Apple menu.
Window Controls Options. Navigation Controls.
The coloured buttons, or gumdrops, are found in the top left These simple controls allow you to retrace your steps

corner. Hover over them and a symbol appears in each ofthem. | backwards and forwards through Finder.

V- | Close . ) Navigate to a
Click once on the red button containing Previous page
. a cross. This will work with the majority @ > Click the left hand arrow. To
of windows and applications. continue stepping backwards,
Back/Forward| repeat step one as many times

r M_Immlse . as necessary.
Click the orange button containing a *-*
sign. Again this will work with almost all AT Using the Forward Control
windows and apps. If you've moved to a previous page,
r_ this button offers step-by-step
Full Screen < @ navigation to your original starting

Click the green button with two triangles. . . . .
t. Simply click th ht-hand
. This will full-screen most windows. Back/Forward RO, SINEly GIok s Honaan
arrow as many times as needed.
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View Window Contents as Icons

To display your files and folders as a collection of icons, first
open a Finder window then click the first button on the toolbar,
showing a group of four squares.
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View Window Contents as Lists

With an open Finder window, click the second button on the
toolbar to use a simple but effective list display.
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View Window Contents as Columns

Click the third button on the toolbar to view your files as a
series of columns. It's great for quick navigation and easy
visual identification using a handy image preview column.
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View Window Contents as Gallery View

The Gallery View gives a large preview of the file or folder that's
currently selected and a scrollable strip of everything else. Click on
one of the files in the strip to see a larger version of its thumbnail.

m 2 = 0 0 o~ #v G
v None
Name
Kind
t;ijr;egering g:f:izz:”(‘)pened \wg 4 —
Change the Way Items
are Arranged.

As well as changing the way the items are displayed, you
can also change the way they are arranged.

Name: Alphabetical. Displays numbers first, then A-Z.
Kind: This groups each type of item together.

Application: Groups together items according to the
application in which they were created or are opened.

Date Last Opened: Groups according to time and
date they were opened.

Date Added: Displays items in order of when they
were added to the folder.

Date Modified: Displays items in the order they were
last modified or edited.

Date Created: Displays the items according to when
they were created.

Size: Arrange the files according to their size.

Tags: Files are arranged according to tags you've added




More Sidebar Functions.

If your sidebar is getting cluttered, you can show or hide its listed
items by hovering over the title (Favourites, Locations, iCloud, Tags)
and clicking the small down-facing chevron or right-facing chevron
— the right-facing chevron appears when the title is hidden, and the
down-facing chevron when they're expended. You can also eject
external drives, CDs and disk images from the sidebar; by clicking
the eject icon next to the device or image you wish to remove.
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[ Using the Finder

Perform Tasks Within the Finder
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1 Click on the three dots within a circle icon (next to the
Search Bar) for a drop-down menu. Here you can do a
range of operations, from opening a highlighted file in a specific
application to checking the file size via the Get Info option.

The Finder’s Preview Panel.
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You can also clean up the entire Finder Window,

automatically tidying up and or reorganising the order of
the files according to various criteria such as their name
(alphabetically), date, size and more.
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Finder windows have a right-hand sidebar that shows a preview
of the currently selected file from the window. You can turn this
sidebar on or off in the View menu (Hide/Show Preview) or press
Shift-cmd-P on the keyboard.
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@ Convert Image

Rotate Left Markup

neering 14.jpg

Customise...

At the foot of the preview sidebar are a set of new options.
These vary according to the type of file you're previewing in the
main window. For example, an image can be rotated, annotated
or converted into a PDF.
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Full-screen Mode

If you want to view the Finder window better or any other window for that matter, then you can always opt to view it in
full-screen mode. Full-screen removes distractions and makes everything a little easier to read. Here’s how it works.

<> Mountaineering Pictures B 5. e~ e Q

ounisheerng  Mountsineoring  Mountainesting  Mountaineerng  Mountaineering  Mountainearing
' osiog 050 19009 209

o i e

rivg  Mountainesring  Mountainewing  Mountainesting  Mountaineering M
oBipg 09iog 10j08 "7ipa

£ DgtalMeds T MoUOlaawri
£ Kingston 368 B

oie
o Biapbon (P
© Dropor (Team 80M)
$ seupo

 airoron

© Recents

A Aopieatons

2 Desktop.

3 Documents

© Downioads

Cioud v
£ shared

5 Dighl Mol

£ Kiogston 858
2 wowyCoudee
® Natwork

® oy
® Pupie

You can view a Finder window and indeed an application

window, in full-screen mode. Click on the green Enlarge
button in the upper left corner of the window and it gives you
the option to expand to fill the entire screen. Alternatively, use
the View pull-down menu or press ctrl-cmd-F

@ Finder File Edit View Go Window Help

" e < > Mountaineering Pictures 23

%2 Dropbo\(Personal) ’_‘w .

3% Dropbox (Ram BDM) |i &

8 Setapp

@ AirDrop Mountaineering ineering

rinacey 02.ipg

@ Recents

4 Applications ——
=

[ Documents

@® Downloads in i

07.jpg 08.jpg 09.jpg
iCloud
& iCloud Drive — p— =

In full-screen mode, the menus usually found at the top

of the Mac desktop are still there but they're hidden
away until you need them. To see them, move the mouse
cursor to the top of the screen and the menu bar slides into
view and disappears when the cursor is moved away.
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To exit from full-screen mode back to the usual window

view, bring up the Menu bar and then simply click on the
green button again. The window shrinks to its previous size
and no longer takes up the entire desktop.

32-Bit Apps No Longer Run.

You can also take a window out of full screen mode

using the View pull-down menu at the top of the screen
or by pressing ctrl-cmd-F You can still close a full-screen
window with the red button (top left).

Apple has phased out support for applications built for 32-bit architecture. These will no longer run in macOS.
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In macOS Monterey, you can no longer open applications made
for older 32-bit processors (modem processors are 64-bit). If you
have such an app on your Mac, it appears in the Applications
window, or Launchpad, with a crossed-out icon atop it.

Try to open a 32-bit app and you get a message saying it's
not compatible with this version of macOS. Check with its
developer whether the app has since been updated to 64-bit,
but if it hasn’t by now, it might well have been abandoned.




Changing the Finder Window’s
Background Colour or Image
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1 When you're using the Finder’s Icon View, you can replace
the white background with a coloured one or even a
picture. To begin, with the Finder window in question open,
select Show View Options from the View menu or press cmd-J.

< Applications.

 oron P -

-—
 Orapbos (Team 80M) e
srenens $ searp Camiiicx  Cowmowtw  Comactt dnoo
8 @ Ardrop
© focens
Aa
A Applcatons

Detorary oropbos

© oo e m a P
Detautt S a
m o - e e
2 o
ol o T
..
e . % O S
B8 Kingsion 868 - Move Kasporsky Keynote Launchoad
2 WoMyCloudex2 art Socrty
® Network :

The window’s Info window opens. Towards the bottom, you

can see options listed under the header ‘Background'.
Select ‘Colour’ and click on the white square. You can now use
the various options to change the background colour.
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Select ‘Picture’ and then drag an image into the box to

the right of the background options to get a pictorial
background. Alternatively, click on the box and then navigate to
the picture you want to use through the Finder.
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Accessing iCloud Drive.

iCloud Drive can store and share files across Mac
devices logged into the same iCloud account.
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Click on iCloud Drive in the Finder window’s sidebar.

You

see the iCloud Drive folder is organised according to apps.

You can create your own folders here too.
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Files and folders found here are synced using iCloud Drive,
so they’re available online at www.icloud.com and also on

other devices linked to the same iCloud account.

e wniose
in}

Files

@) Recents
[ Shared
Locations

* Templates for Abteivon Advertising
Appleuser Malmesbury contract

Favourites

@ Downloads

BOM Address 80M
Label

Assassin's Creed

w
w

8DM Comp Sips 80M Compo Blank2

wners.

AD Chvistmas.

Treat

Collection
sip

Cafo oaflet

Here we’ve opened the Pages iOS app on an iPad. As you
can see, the documents in the Mac’s Pages iCloud Drive

folder are also available to open and edit here.
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Monterey’s Dock
sss) For Most-used Apps

The macOS Dock is a feature that greatly speeds your workflow. It's perfect
for gaining quick access to the most relevant and frequently used applications,
documents and folders. It's customisable too, which means you'll come to
personalise your Dock to best fit your own unique needs. Here’s how it works.

Accessing Your Applications from the Dock

Add or Remove an Application Move an Application

To add an app, first click the icon filled with multicoloured To move an item to a new location in the Dock, click and
boxes on the left-hand side of the Dock to bring up drag to the required position. As you move the item the
Launchpad. Then, click and drag the item you want onto the adjacent applications will move aside to allow you to drop
Dock. To remove it, just drag it out. the icon into its intended place.

!Hb me .
' @@ "0820Ne BOEA |

Open an Application Recently Used Applications

To open an application that's in your Dock, simply move the Applications you've recently used are shown in their own
mouse pointer onto the Dock and click on its icon. Notice section in the right-hand side of the Dock, from where they can
that the app icon slightly bounces as the application opens be used like any other Dock app. A divider separates

before the main app opens. permanent and recent apps.
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Adding and Removing Stacks

You can add, remove and move folders in your Dock, in the
same way you do with apps. These sit to the right of the
Dock’s second divider and are called Stacks.
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Accessing Stacks

To access the files and folders within a Stack, click on it to
display the contents. Clicking on a document or image
opens it with an appropriate application and clicking on a
folder opens it in Finder.

Sort by
v Name
Date Added
Date Modified
Date Created

Kind

Display s
Folder
v stack

C eI~ EYel. m‘gg

Viewing Options
Right-click or ctrl-click on a Stack for a pop-up menu with a
range of options. You can show your files as a Stack (a pile of

files) or as a folder. You can also choose how they're displayed
when you click the Stack.

Monterey’s Dock

The Bin.

The Bin icon is located at the far right of the Dock and
can be filled and emptied just like a real rubbish bin.

Mountaineering
16.jpg

You can delete a file, folder or app by dragging it into the Bin
on the right-hand side of the Dock. Alternatively, right-click or
Citrl-click on it and select Move to Bin from the contextual
menu that appears.

Open

Empty Bin

To retrieve a file from Bin, click on the Bin icon in the Dock
to open it in Finder, then drag the file out of the Bin window.
To empty Bin, right-click on it and choose ‘Empty Bin’, or in
the Bin window, click on the Empty button (top right).

Customising the Dock.

You can customise your Dock in System Preferences from
the Apple menu and selecting Dock & Menu Bar. From
here, you can place the Dock on the right, left or bottom of
the screen, opt to show and hide it, change its size, change
its magnification, choose a minimisation effect and more.

° < i Dock & Menu Bar

Dock & Menu Bar Dock
Size: Magnification:

small large min

o
Left  Bottom  Right

Position on screen:

Minimise windows using: Genie effect &
Double-click a window's title barto zoom @
Minimise windows into application icon
Animate opening applications
Automatically hide and show the Dock
Kuybeam Bm;nlness . o
& Show indicators for open applications
Show recent applications in Dock
(O Screen Minoring
W Bar & Control Centre.
Menu Bar

D!wﬂy
ot & Convl Contre Automatically hide and show the menu bar on desktop
Automatically hide and show the menu bar in full screen ¥
oy Sound
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® Notifications
See What's Going On

Apps and functions on your Mac can send you notifications, which let you know
what’s going on. WWhen you receive a message or an emalil, for example, you
can get a notification telling you that it's arrived. You can customise them too.

@ Finder File Edit View Go Window Help

If you came to
Monterey from a
pre-Big Sur version of
macOS, you might
look for the
Notification Centre
icon in the top-right
corner of the screen.
However, it's not
there. Instead, Apple
has integrated
Notifications into the
Date/Time and
Widgets zone.

Moving notifications to the Date and Time and combining them
with widgets is a clever move on the part of Apple. All you need to
do to view your natifications is to click on the Date and Time in the
top-right of the desktop. If there are any, they appear at the top of
the slide-in area that appears from the right-side of the screen.

Notifications are grouped together depending on the app
they’re coming from. For example, the News app displays
notifications based on what news channels you've decided can
send alerts to you. If you click on a notification in the group, the
rest expand so you can see all the available notifications of that
group. And clicking on a natification, whether it's from
Messages, News and so on, opens up the corresponding app.

This makes viewing notifications a much more efficient
process, since there’s a minimal need for mouse clicks, and
it's easy to see which notification belongs to which app. If
you’re on the lookout for an important news flash report, for
example, you can quickly get the information you need when
it appears on your screen.

®@ 9 2 Q8 7T B2 & 2 O sa20ct 1229pm

New Photos Memory 28m ago

t Pet Friends .

"4 House of Felix Yesterday, 719 pm
The home hub is not responding.

After All 3 days age
Elton John & Charlie Puth — The
i Lockdown Sessions

Notification Centre

New Edits
lan & Alison’s Jobs List

Weekly Report Available 5 days ago
YYou averaged 4 hours, 56 minutes of
screen time per day last week.

Things 7days ago
Cross-Trainer

Newton Abbot OCTOBER
132 '

-
Heavy rain in the

45678090
Mz 13 18 18 18 17
18 19 20 21 22 23 2
25 26 27 28 20 30 3

Jon White 6m ago
. Seeing Bruce Foxton & The Jan on Friday, in
% Liverpool, and Motorheadache at Chester in
November
Stranglers in Feb....

New Photos Memory 41m ago

& Pet Friends a

Hover over a natification for an expansion chevron in the
upper-right corner. Click it and the notification expands to display
more information. In addition, by moving the mouse pointer over
the notification bubble you'll also see an X in the opposite top
corner, for dismissing the notification.
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Creating and Removing Notifications

6 +ae=>ml & 0 wioa

Notifications & Focus |

lan Osborne Notifications ~ Focus
Aoie 10, Ciov, esis & Agp tace

it System Preferences

Notification Centre shows your alerts in the upper right of your screen, without interrupting what
you're doing. Show and hide Notification Centre by clicking the clock in the menu bar.

Amphetamine

ot @) Alow Notifications

Sbpisiond Calendar alert style:
BitLord

o off

m Books

&m Calendar

17 8adges, Sounds, Banners Banners appear in the upper-right corner and go

s Canary Mail ;way automatically. Alerts stay on screen until

F  Badges, Sounds, Banners imiifaec

= Clean Drive Allow time-sensitive alerts

< otf Show notifications on lock screen

i e Show in Notification Centre

g CleanMyMac X HeaithMoni. badasippicon
oft Play sound for notifications
Dropbox

i i ifi i i i ¢ Show previews when unlocked (def...
Adding and removing app notifications is as simple as < I e ;
: : - " Dropbox Notification grouping  automatic
navigating to System Preferences > Notifications &
) ‘ I . f Energy Saver
Focus. It's the ‘Bell’ icon on the right-hand side of the System L

Preferences window as it opens. it ] )
From there. click the Notifications tab and you’re Allow notifications:  When the display is sleeping % When the screen is locked

When mirroring or sharing the display ?
presented with all the available apps installed on your Mac

that can provide a notification of some sort. Scroll through

the list of apps on the left pane of the Notifications window When you've found the app you want to create a
until you find the app you want to setup Notifications for, and Notification for, click on the ‘Allow Noatification from...’
click on the name of the app. slider button to activate it.

ences Edit View Window Help

Notifications & Focus

Notifications ~ Focus

3 Q 8 & wa & | O sat20ct 1:13pm

Notification Centre shows your alerts in the upper right of your screen, without interrupting what
you're doing. Show and hide Notification Centre by clicking the clock in the menu bar.

Amphetamine
C‘ off (D Allow Notifications

Amar Yapp 30m ago
Did you get the parcel | sent? (3

gﬁp Store Calendar alert style: Jon White 36m ago
" Seeing Bruce Foxton & The Jan on Friday, in

w Bittord Q Liverpool, and Motorheadache at Chester in

off November

Books Stranglers in Feb....

Sounds, Banners, Time Sensitive None Alerts

Calendar

Badges, Sounds, Banners Banners appear in the upper-right corner and go

Canayl away automatically. Alerts stay on screen until

dismissed.

Badges, Sounds, Banners

Allow time-sensitive alerts

W AS =)

Clean Drive

oft Show notifications on lock screen

S‘I.eanMyMac X Show in Notification Centre

CleanMyMac X HealthMoni... Badge app icon Newton Abbot

off Play sound for notifications o

Dropbox N 1 4

off Show previews when unlocked (def...

Dropbox Notification grouping v automatic ) - 11213 18 15 16 17
G Eneray Saver off next hour 25 26 27 28 29 30 3

Show previews: when unlocked

Allow notifications: When the display is sleeping When the screen is locked
When mirroring or sharing the display

Cupertino Tokyo

3 Within the Notifications window, you can set a number of
options for how you want to review any Notifications from

the app you've activated. For example, the Alert Style can be ' sl @ A e " ' ﬁﬁ
adjusted to None, Banners (the default, and the one that most

folk will use), and Alerts. You can also opt to display As you continue to use your Mac, so the number of
Notifications on the lock screen — although this is considered a Notifications you generate will increase, over the course of
security risk if you leave your Mac unattended. There’s also a week or even a day. You'll quickly come to appreciate the
options to play a sound when a Notification comes in and you Notifications layout and design and how it greatly improves the

can set the Notification Grouping to Automatic, By App or Off. process of discovering alerts and notifications.
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Working with
Monterey's Widgets

Widgets are a useful way of getting quick and easy access to an app’s
functionality, without having to open the app itself. You can, for example, see
today’s calendar events or weather, or check the latest news stories from the
Apple News app. You can edit your widgets to suit your needs too.

First Steps with Widgets

T B Vv Go Vinaow e T 0§ A% T W & ¥ O muswiHm

1 To access your widgets, click on the clock and date in
the top-right corner of the screen. The widgets are found
underneath the notifications. You can scroll the notifications
and widgets up and down with two fingers on a trackpad.

FRIDAY
Newton Abbot
2382

Partly Cloudy
H:23° L:8°

Top Stories
sy IR
to hold urgent talks on

3 You can drag widgets out of their current position and
drop them into a new place, just like you do with app
icons in Launchpad. Reorder them to suit; maybe move the
most used widgets to the top of the column.

® 0 ¥ as = W & ¥ O sk sm

Top Stories
=
Ministers to hold urgent talks on
drivers! a5 AA urges
‘matorists not to take more fuel..
™M em v 2 sy

Why i there a shortage of lorry
drivers? The UK's fuel crisis
explained

(2]

“News+

NEWS EDITORS' PICKS
Isthe “fertility cliff* just a myth?

s,
¢

uuuuu

Ameriprise Financial Inc. stock underperforms Monday
; whencompared to competitors

E Click on a widget to open the app that created i, or in
some cases, the website from where its information is
drawn. Here we clicked the AMP share price in the Stocks
widget, which opened the Stocks app on the AMP details page.

NEWS EDITORS' PICKS
Is the “fertility cliff” just a myth? ?

Size
Small

v Medium
Large

Remove Widget

Edit Widgets

O 2h47m

60m

30m

Right-click on a widget for a contextual menu that lets

you resize the widget, remove it or access the option for
editing widgets. You can do all this through the Edit screen, of
course, but this is a quick and easy alternative.




Editing Widgets

1 There are two ways to access the Edit Widgets option.
You can either scroll the widgets column all the way up
and click the Edit Widgets button at the bottom, or right-click a
widget and choose Edit Widgets from the menu.

3 Click an app on the left-hand side of the screen to see
the widgets associated with that app in the centre
column. To install a widget, drag it from this centre column into

your widgets on the right-hand side of the screen.

s ;

it bl gt s on

i

e e .

Yt rorsnotony
'Hlul)K fuel crisis @

Some third-party apps have widgets. Sometimes an

unused third-party widget is blank until you open its
associated app. If you're interested in that widget, just open
the app and return to the Edit Widgets feature.

Monterey’'s Widgets

MTWTESs s

11415 18 7 18 10
wnn2n@:

27 28 20 30

Top Stories

Ministers to hold urgent
driver shortage as AA u
motorists not to take m(

Why s there a hortage
drivers? The UK's fuel
explained

éNews+

NEWS EDITORS' PICKS
Is the “fertility cliff” jus{

When in Edit Widgets mode, the widgets in your sidebar

have a minus sign in the top-left corner. If you want to
delete a widget, click on this minus sign and it disappears. You
can add it again later if you want it back.

Top Stories
=

Ministers o hokd urgent talks on ;
driver shortage as AA urges.
motorists. nonn hkﬁ ‘more fuel...

wny is there a shortage of lorry

drivers? The UK's fuel crisis
explained

“News+
NEWS EDITORS" PICKS =
s the “fertilty cliff” just a myth? ‘ S+

Some widgets are available in Small, Medium and Large

versions. Click on the circles labelled S, M and L
underneath a widget to see what each size looks like, and
when you've chosen a size, drag it into your column.

Today

Third-party widgets won't update unless the app to which

they refer are open, but if this is a problem for you, simply
set up that app to open whenever you log in, and leave it open
in the background. The widget then stays up to date.
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The Spotlight Feature
Search Your Mac

Spotlight Search is Apple’s unique and ultra-powerful search system that
can find almost anything on your Mac. There’s a whole raft of great features,
making it a really powerful and useful tool that’s integrated into the apps that
you use every day. Here’s how to get the most from the Spotlight feature.

Using Spotlight’s Features

® 0 t QS * & & O fuswaem

Q numbers

y @ Numbers — Applications
QBpotlight Searct | ] Numbers — App Store « Productivity - % ke % (122K)

@ numbers

— 237 KB - Pages Document - Last Opened 06/08/2021, 3:35 pm
212 KB » Numbers Spreadsheet - Last Opened 15/03/2021, 12:4...
« Last Opened

part of the body) deprived of the power of physical sensation

1 To start using Spotlight, press cmd and the space bar or Start typing your search query into Spotlight and
click the magnifying glass in the top menu and the immediately answers appear, with suggestions based on
Spotlight Search window appears. In Big Sur, as with macOS the contents of your computer as well as other sources. This
Catalina, you can drag this window to wherever you want on may mean you only have to type a few letters of your search
the screen; it's not fixed in position. term to find what you're looking for.

Q 2-4kd= 5.29 pounds Q10 pa}secsl = 3262 light years

— answers,com..,/What_ls_2_stone_4_pounds__... solstation,comystars/pci0 him

/Answers — answers.com/.../How_much_is_2_stone_d_Ibs... 0 parsec com/stars/pc10bd htm

I Passenger V... — epa.gov...[greenhouse: gas-emissions-typl... -solstation.com/stars/pc10wd.htn

3 Spotlight can do instant unit conversions for you. For It works in a similar way with distances and lengths,
example, if you want to convert from imperial to metric which Spotlight can instantly convert into other units. For
weights (or vice versa) you just type in the number and a type example, if you type a distance in miles it instantly shows what
of unit, such as kilograms or pounds and Spotlight instantly it is in kilometres, metres, yards, feet and inches. You can even
converts into other commonly used units. convert parsecs into light years.



llars = 73.09 sritish pounds

| 0 100 dollars = 73.09 British pounds —yahoo!

35 KB - Microsoft Word Document » Last Opened 20/04/2021...

Spotlight can do some currency conversions. Type in a

number and currency unit, such as dollars or pounds,
and Spotlight gives you the equivalent value in a range of
currencies at the current market value.

Meat59
Burger Restaurant
#4.5 (694) on TripAdvisor - EE£E

TURKE

Torquay

Meatso

7 If you're looking for local businesses or sites of interest,
simply type the name into Spotlight and you'll quickly
find what you're looking for, complete with a link to the Maps
app and the option of travel directions from your current
location plus other useful information.

cturd — IMG_5857jpeg

IMG_5857.jpeg

Spotlight is also closely integrated into the core macOS

apps, such as Photos. Start typing in your search term,
like the title of a particular image or photo album in your Photos
app, and Spotlight quickly locates it and takes you straight to it.

The Spotlight Feature

Singapore
Republic in Southeast Asia

singapore, officially the Republic of
A% singapore, is a sovereign island city-

state in maritime Southeast Asia. It lies
about one degree of latitude north of the
equator, off the southern tip of the

Malay Peninsula, bordering the Straits of Malacca to the

west, the Riau Islands to the south, and the South China

Seato the east.

For more conventional searches, Spotlight pulls its
information from a wide range of sources, such as
Wikipedia and documents it finds on your Mac. Search results
are listed by category down the left side of the search window.

<* Alyssa Falcon
" TIVRATech

©co - o

message  Phone  video

Phone 020 7930 8181
FaceTime #¢ \

home alyssa_falcon@icloud.com -
Homepage http:/fwww.corinthia.com/london

work London
England

You can find people with Spotlight too. Start typing the

name of someone you know, and Spotlight quickly finds
that person in your Contacts list and displays their contact
details in the results window. Things like chat threads,
Facebook comments and emails are also listed.

Ace of Spades

Apple MPEG-4 audio - 6.1 M8

Created 24 September 2021
Modfiad 24 Sen a2 bt 41 £
Last Opened 24 Sep 2021 at 3:42 pm

7 Ace of Spades Duration 2:47

T Spotlight can find music by searching through your iTunes
collection to find albums, tracks and artists. Type a band

name, a track name or even the name of a band member.

Recordings with that name or by that band or person are shown.
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- Launching Apps
And Quitting Them

There are several ways of launching an app on your Mac. You can: use the
Launchpad, which is found in the Dock; you can open a Finder window and
navigate your way to the application you wish to use; or you can click on the
Spotlight feature and simply type its name. Here’s how to do it.

Using Launchpad

B0 =0V B8 00820e By mWi¥

1 To open the Launchpad, go to the Dock and click on it, If you have more than one page of apps, move between
or place four fingers on your trackpad and bring them them by swiping left and right with two fingers or hold
together. The screen darkens and your apps are shown as cmd and use the arrow keys. Click and hold on an app and an
icons. To launch an app from this screen, click on it. To close ‘X appears in the top left corner; click ‘X’ to delete. Not all
Launchpad, press Esc or click on the desktop. apps can be deleted in this way.

iWork Apps

10 =0 @8- "9020e wo@ ol

3 You can arrange your apps into folders on Launchpad Open and close folders by clicking on and off the folder
too, just like on an iOS Home screen. Just drag one app icon on the Launchpad screen. You can add new apps
onto another and a folder is created. You can click on the into the folder by simply dragging them onto the folder. You can
name if you wish to change it and to remove an app from that also drag apps around the Launchpad window to change the
folder, drag it off the grey folder area. order in which they're arranged.



Using Spotlight

& Finder Fie Eai Vew Go Widon Hel

1S F & B O Fi2ases &isem

1 To launch an app using the Spotlight feature, first click
on the magnifying glass found in the top right corner of
the screen. A window saying ‘Spotlight Search’ pops up. If it's
inconveniently located, you can drag it around the desktop and
move it to wherever you like.

Using the Finder

% Dropbox (Personal)
% Dropbox (Team BOM)

You can also launch an app using the Finder. Open a new
Finder window (or use one that’s already open) and click on
Applications in the sidebar. All of your Mac’s apps are
shown. Scroll to find the one you want to use and then
double click on the icon to launch.

Quitting Apps.

Show All Windows
Hide

Open apps are shown in the Dock. On the app’s Dock icon, you
can click using the right-hand side of a Magic Mouse or trackpad
(right=click), hold the Control key and click anywhere (ctrl-click) or
click and hold, then click on Quit in the pop-up window.

Launching Apps IE-

Begin to type the name of the app you want to launch

and Spotlight tries to complete it for you. When you see
the name of the app you want, scroll down to it and press
Enter and it launches. To close the Spotlight search window
without launching anything, just click anywhere on the screen.

Using the Dock

B0 A0

You can launch an app from the Dock. If your Dock is hidden,
move your pointer to the foot of the screen to reveal it and
click on the app you wish to use. To find out more about the
Dock and how to customise it with your favourite apps, see
our tutorial later in the book.

® 0 + Q® = & @ O maseanm

Alternatively, with the app to the fore in Finder, click on its name in
the top left corner and select Quit [app name] from the menu; or

hold the Command key and press ‘Q’. Just make sure the app is
open on your desktop or you might quit the wrong application.
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XA

Setting Up Email
For the Mail App

With email, you can send mails and attachments anywhere in the world, at the
push of a button. It's there instantly too. Here we take a look at what email is,
how you can get yourself an email address and how you can use your email
accounts on your Mac, with Apple’s bundled email client, the Mail app.

Setting Up Your iCloud Email

Optimise Mac Storsge

Cloud Storage: 50 GB (2197 68 Availabie)

1 If you set up your Apple ID during your Mac’s initial
setup, or if you signed in with an existing Apple ID, your
iCloud email account is already in place. But if not, or if you
want to add another iCloud email account to your Mail client,
follow these instructions.

gy Amazon.co.uk
Kindia Daly Desk: Books Irom 999

fne,

jave mors than T0% on 7 Wies,
Jgs by Victoria Connally, The
$0 and The Parfact Drass by

Now enter the Apple ID for the iCloud email account you

want to add to your Mail app, and then the password.
When you have confirmed your details you can then click on
the Sign In button to take you to the next step.

9 Amazon.co.uk
© o es:sess romsen
: B
iCloud |
Microsoft Exchange [
Google
yaheo! Isborn
fans sy
Aol. laTings
Vorteven|
Other Mail Account i Beown|
cancel #m

i pAzam

Open the Mail application from the Dock and then under

the Mail drop-down menu found in the left of the menu
bar, click on the Add Account... link. From the pop-up menu
that appears, select the iCloud link and then click on the
Continue button to go to the next step.

iPhone 13 Pro

Oh. So. Pro.

Learn more >

On the next screen, click on Add Account and your

iCloud account is added to the Mail app, for you to use
on your Mac. Your iCloud email can be your sole email account
or you can use it in Mail or alongside others if you wish.




Setting Up Other Emails

Safar Fie EdN View Fistoy Bookmarks  Window Hep
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& virginmediacom
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Settmg up my Virgin Media email on a device

want quick access to

Virgin Media email through your web browser, follow these steps:

You have two choices of settings to use with Virgin Media email - IMAP or POP.

IMAP (recommended)
POP

Setting up Virgin Media email on a new device

hosen the best setting o identified which one you are already using, follow the relevant link to the device or application
s your Virgin Medio email on:

* 0 Device
* Android
* Windows 10
* Outlook

* Mac

To configure your Mac to access your email account from

your Internet service provider, you need your email
address, your password to access your email account, and POP
or IMAP (incoming) and SMTP (outgoing) server addresses.

Setting Up Email

E macOS Monterey includes a sophisticated email program,

simply called Mail. You can find it on the Dock, as it's there
by default. The Mail App’s icon shows the back of an envelope on
a blue background. Click on this icon to open the Mail app.
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Cloud T
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Microsoft Store Into a
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3 When you first open Mail you're prompted to set up your
first email account. If you've previously used Mail or set
up another account, you can add further new accounts by
going to the Mail menu and selecting Add Account.

SUBTITL
SCREEN

Vue inbox - Pipax  £:07 pey
Fims showing from st £4.99 at. SHALL PEOPLE. 816 DXPURINCE
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To get started, fill out the following information:

Name: lan Osborne

Email Address: ||

Netflix m[»nJ
fan Osbome, wa{

Password:

ad

ok Cancel
Microsoft Storey
Got film deals, the
Shop tilms an TV now

The Independ... | B/03 sm
Peteo sations close amid deiiver

Amazon Alexa invor 09 ar

If you're adding an account from your Internet Service

Provider, select Other Mail Provider from the screen in
Step 3. Enter details such as username, password and server
information provided by your ISR The server information should
also be on the ISP’'s website.
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Email Address: || ]
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If it's another web-based email service you're adding,

you must now enter your full name (this appears in your
own, and other people’s, contact lists), your email address and
your password. Do this, and your account is added.
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Fill in all the information for which you're asked. The exact

information required depends on the service provider in
question, but it typically includes incoming and outgoing mail
server addresses, your username, and your password. When
you've finished, click on Sign In to finish.
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Installing New Apps
@ On Your Mac

Installing new apps on a Mac shouldn’t be a terrifying experience. Whether
you’re downloading from the App Store or from a third-party developer’s
website, you can download and install some great new software
applications, or apps, on your Mac in macOS Monterey.

You can open the App Store app

from the Apple menu, as well as
from the Dock, the Applications
window, the Launchpad and Spotlight.
If updates are available for any of your
apps, this is shown in the Apple menu,
next to the App Store option.

Type the name of an app, a

developer or a genre into the
Search window to search the App Store
for apps. Your search results are then
shown in the main window.

® AppStore Edit Store Window Help

Q search

¥ Discover
<& Arcade
& Create

</ Work

7 Play

2® Develop
88 Categories

@ Updates

Ap
s lan Osborne

The sidebar gives you options

when exploring the App Store.
Discover is best for general browsing,
Arcade is for Apple Arcade titles, then
there are categories for creative apps,
work-related software, games
developers’ tools and more.

This is the featured app of the
day, chosen by Apple’s editors.

Click on the chevron for more
featured apps.

FEATURED APP 4

The code and text editor
of champions

s way beyond thasBsics. Mest
tor of chanipions.

FEATURED GAME
Play your cards
right

Go it alone with Full Deck

ps and Games We Love Right Now B

PopClip

MacBook Pro

Turnip Boy Commits Tax Evasion

More from Apple’s editors. These

boxes might feature individual
apps, or they might offer a range of
titles on a given theme.

7 Click on your name in the corner
here to get your account details.

Scroll the page down for

individual apps and more. Click
on an app to be taken to its page. Click
on its price (or the word ‘Get’ if it's free)
to buy and download it.

LEARN SOMETHING NEW
Get schooled in
science

Never stop learning with these
Solitaire. s " apps.

See All

£12.99




The Mac App Store

The Apple Mac Store is an impressive market place of apps, that
have been registered and cleared with Apple to run on your Mac
without any hint of anything unwarranted — such as malware. But
it doesn’'t have everything on offer. There are times when you may
need to go outside the Mac App Store in order to get hold of a
vital app, and this is where the confusion often arises.

[ Installing New Apps

Beyond the Mac App Store you'll find all manner of different
kinds of apps and these are often packaged differently
depending on the developer. You can find DMG files with apps
inside them, PKG installers and even Zip archives with
applications inside. Let's keep things simple to begin with and
start with the Mac App Store.

Installing from the Mac App Store

The Mac App Store is a safe and friendly place for the Mac
user to visit and install apps from. Open the App Store via the
Dock and you'll notice that there are categories on the
left-pane, while the content relating to each category is in the
right-hand or main pane. There’s also a handy Search bar at
the top of the App Store window.

Format academic papers with ease

®

1 To install an app from the Mac App Store, either locate it
via the Search bar — providing you know what you're
looking for — or select it from one of the categories.

Edit_Store Window Help.
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7 Discover
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£ Create
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< Play

2 Develop
88 Categories.
@ Updates

Trello gives all your projects, at h
Bring Trelio to Mac in a dedicated workspace. The Trello Desktop App features.

native notifications, powerful enhancements and more - away from the distractions
ofyourbrowser.  moe
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3 The downloading and installation process may take
some time, depending on the size of the app your
installing and your connection to the Internet. Progress is
measured with a circle where the Install button was, which
is gradually filled as the app is installed. If you need to
cancel the installation at any point, then click the square
inside the gradually filling circle.

L N <
Q search
Trello
S Organize anything, together
& Arcade GET

& Create

< Work

& Play

2> Develop
B8 Categories
@ Updates

£ Mac

Trello gives you perspective over all your projects, at work and at home.
Bring Trello to Mac in a dedicated workspace. The Trello Desktop App features
native notifications, powerful and more - away from the

When you've found the app you want to install, click on

the Get button (for free apps) or the price button (for
paid-for apps). This button changes to a green Install button,
and when you click on Install and sign in with your Apple ID,
your new app downloads and installs on to your Mac.

SideNotes Bartender

devolo Cockpit

T2 o=E W

Once the app has finished downloading and installing,
you can either click the Open button — which has
replaced the filled circle in the Mac App Store — or you can
find the newly installed app through the Launchpad via the
Dock. Updates are handled by the App Store and anything you
purchase on one Mac will work on another compatible Mac. It's
a quick, simple and convenient way to work.
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Thlrd-party Apps

Installing from developers’ websites does carry some baggage. For one,
you’re not going to get updates from the Mac App Store, which may lead
to an unresponsive app as the core macOS system is updated. Secondly,
there’s a potential security risk, as you've no way of knowing if the app
you're installing has any form of malware hidden deep within it. And thirdly,
it's not often quite as simple as a single click.

NEW

toast 20

DVD authoring, disc burning, audio & video
capture, and screen recording software for Mac

LEARN MORE

Begin by locating the app you want to install — as

previously mentioned, look for a reputable site. Ensure
that it actually has a macOS version available, as Windows
or Linux developed apps won't work on a Mac (unless you
do some clever work in the background).

Get your Roxio software here!

Download your tal copy now.

fal number or attac

Roxio Toast

There’s usually a Downloads section to any site where

there’s apps available from the developer. In there you
can find the macOS specific installation file you need for the
app in question. Click the link to it or button, to begin the
download of the app’s installer.

oo Downloads

% Dropbox (Personal)
% Dropbox (Team BOM)
$ Setspp

 Aidrop

@ Recents
A, Applications
= Desktop

[ Documents
® Downloads

3 Most macOS downloaded app installers come as DMG
files. A DMG file is an Apple Disk Image file or a Mac OS

X Disk Image file. It's basically a digital reconstruction of a
physical disk and stores compressed software installers
instead of having a physical medium. These DMG files can
therefore be mounted as virtual disk images.

All downloads from Safari are stored in the Downloads
folder in Finder. Locate the folder and the DMG file you've
downloaded, then double-click to mount the virtual disk image.

ew Go Window Help @ ® 3 QS 7 m 4 & 0 T

® 0 ®  [IToast 20 Installer

This does one of several operations: first, macOS will

scan the DMG file and ensure it's all there and in the right
order to read from. Secondly, it will open a virtual disk image
both on the desktop and within Finder as a new external drive.
Thirdly, you'll get a brief notice indicating how to install the
chosen app on to your system.



L] [2) Retro Virtual Machine v2
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Retro Virtual Machine 2 Retro Virtual Machine 220

cheatsheet

If there’s an Applications folder in the window with a

small arrow in its bottom-left corner, drag the application
into this folder to install it. If the folder contains a file with a
name that ends ‘installer’, double click on that file to start the
installation process. Follow the on-screen instructions to
complete the installation. You'll then find the intsalled software
in your Applications folder where you can choose to add to
your Dock if you want to access it quickly.

roxio

toast 20

Third-party Apps

YYou are opening the application
'm:'“ |g||1.?|"n hp,p.h. first “Toast 20 Installer" is an app downloaded from the
time. Are you sure you want to internet. Are you sure you want to open it?
open this application? B
application s in a folder named
*Toast 20 Installer". To see the
‘application in the Finder without opening
It, click Show Application.

R
e

]
[ Toast 20 Installer > @0 To

{14 www.roxio.com

Don't warn me when opening applications on this disk image

ast 20 Installer

Because the application was downloaded from a

third-party site, you might get warnings such as the
ones shown here. If you're sure you downloaded the app
from a reputable site, click on Open to proceed. You might
also have to open System Preferences > Security & Privacy >
General, click the lock (bottom left) and enter your admin
password and make sure the lower option is set to ‘App Store
and identified developers’.

@0 8 QST m L& O Mmusonm

5 RPDVDIoDighl & Craste Encaypied Disc

& Capturo Scroen
Recordng

7 If you bought the app from the developer’s web store,
you might have received a registration code by email.

This might be required during the installation process, or you
might be able to use the application for free for a set period
of time before a code is needed. If you're asked to input a
code during the installation, copy and paste it from the email
into the fields provided. Having done so, continue to follow
the on-screen instructions.

What are PKG Files?

One other popular file type for macOS installations is the
PKG file. Although it's not as popular as DMG files. Simply
put, a PKG file are installation packages that generally
contain automated scripts that will direct the installation of the
app in question. They will take you through a kind of setup
wizard and create a multi-step installation process.

They are usually only used where multiple additional
components are required by the app but also when different

The app should launch as expected. If you come across

any problems, it's often down to the fact that you are
running a more recent version of macOS than the app was
designed for, or the app is 32-bit, whereas macOS Monterey
will only execute 64-bit apps. If this happens, it's worth
checking with the site you downloaded it from; perhaps there’s
a more recent version to download. Otherwise, you could
Google the error and see what other users have to say about
the matter. Most apps often produce unique errors depending
on the developer and the app, so don't always expect the
same solution to work all of the time.

services are required from macOS or the installation files will
be placed in different areas of the Mac'’s file system.

One more note: Once you've installed any DMG or PKG
file, you can delete it from the system. Its job is finished now,
and the app is installed. Unless you'd like to keep it in case
you install it on another Mac, there’s no need to keep hold of
it in the Downloads folder. Simply drag it into the bin and then
empty the bin to delete it from your system.
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MacBook’s
Key Apps

One of the best things about the
MacBook is that it comes with a wealth of
preinstalled applications, or ‘apps’.
There’s the Safari web browser, the Mall
email client, productivity apps such as
Calendar, Notes and Reminders,
entertainment apps like Apple TV, Music
and books, and more. Here we tell you
all about them.

Learn more >



MacBook’s Key Apps ’

Safari
Your Web Browser

Safari is your Mac’s built-in web browser. With it, you can explore the
worldwide web, enjoy your social media accounts, buy and sell on eBay and
more. With macOS Monterey, Safari gets an
overhaul with a great new Group Tabs option.

This icon opens and closes the
sidebar on the left.

Here you see how many tabs

you currently have open in
Safari. Click the four-squares icon to
see those tabs as thumbnails in the
main window.

This icon gives you a menu that

lets you make a Tab Group of
the tabs you currently have open, or
start a new, empty Tab Group to
which you can add tabs manually.

These two chevrons are your

navigation controls, which let
you move forward and backward
through your browsing history:.

Click the house icon to take you

back to your designated
Homepage. Change this Homepage in
Preferences > General.

A lot of websites use trackers

to track your browsing from site
to site, in order to target advertising.
The Shield icon lets you see what
trackers have attempted to track you,
and lets you Turn On Private Relay
(iCloud+ required).

7 This is the URL Bar. Enter the
website address of your choice
or a search term that you wish to look
up into this bar, then tap the Return key:

If a web page fails to load

properly or you wish to check if it
has updated, you can refresh it by
clicking on this button and reloading.

68 | wwwpclpublications.com

Click on the Sharing icon to see

your options for sharing the
page you're viewing; adding it to
Notes, making a Quick Note and
options for Add Bookmark and Add to
Reading List.

Click the + icon to open a new,

blank tab. You can then goto a
new website without closing the one
you're currently viewing.

This takes you to the Tab

Overview, showing all your
open tabs as thumbnails in the main
window. Click on one to open it.

Your Tab Groups. Click a group

to close the tabs you currently
have open, and open the group of
tabs you selected. To return to the
tabs you had open before, click the ‘X
Tabs’ option above it (Item 2).

These are sites that you've

pinned to your tab bar, where
they remain. Click on one to open
that tabbed site.

These are your currently open

tabs. Click on one to open it,
hover over the tab and click the ‘X’
on the left-hand side of the tab to
close it, and click the ‘+’ icon (Item
10) to open a new one.

If someone shares a link with
you in the Messages app, it
appears here.

N

Learning German m

Social Media

Cute Cats
Video Games

Apple iPhone

s Shared with You

[1 Bookmarks

Reading List




Click these links for a list of your

Bookmarks or sites you added to
your Reading List. After doing so, click
the chevron in the top-left of the sidebar
to return to the sidebar shown here.

17 This is where the web page
you're viewing is displayed. You
can then scroll up and down by using
the scroll function on your mouse or
trackpad, and navigate to new pages
by clicking on links, which can be
menus, buttons, text or images.
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Window | Help
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Mac - Apple (UK)

New
iMac
Say hello.
From £1,249

Learn more >

apple.com

¥ Black Dog Medi... W Wikipedia

MacBook

[ Safari F @

Full Screen.

Browse in full-screen
mode by clicking on the
green gumdrop in the top
left corner, selecting Enter
Full Screen in the View
menu or pressing fn-F. To
go back to regular
browsing, repeat any of
these options.
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Set New Home Page

@& Safari File

Accessing Websites

@ sSafari File Edit View History Bookmarks Window Help ® 9

Edit View History Bookmarks Window Help

‘About Safari
Safari Extensions...

Preferences.
Privacy Report..
Settings for bdmpublications.com

Clear History...
Services

Hide Safari
Hide Others
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Quit Safari
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brtal My Account  Help
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 Always Show Toolbar In F
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Hide Status Bar
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Show Reader
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Stop
Reload Page

Translation

Zoom In
Zoom Out
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1 Open a new Safari window and navigate to the web page
that you want Safari to load each time you launch the
app. Click the Safari menu (top left corner), then select
Preferences to display Safari's preferences dialog box.
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File download location:
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5 Downloads
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1 Open “safe” files after downloading
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BDM Learning Bundle Free Guid
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Download
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Discover new uses and

1 To access a new website in the Safari browser, first
double-click in the URL bar, highlighting the text within it,

then type a new URL in this bar. A URL is the website’s address,
which starts ‘www’. Press return at the end to go there.

hipsiwww.apple.com

An all-now Safarl

People also ask

Is Mac Monterey available?

What Macs will run Montarey?

‘Whatis the next macOS after Montoroy?

How do | update my Mac to Monterey?

Ensure the General tab is selected and press the Set to

Current Page button. The required page address now
appears in the text box above. It's now your default home
page. The Home menu in the toolbar will take you there.

Using Links.

If you want to search for something

on the web, instead

of typing a URL in the URL bar, type what it is you're

searching for, then hit Return. Your search results show relevant
sites. Scroll up and down the list and click one to go to it.

‘Showing 1-24 of 73 results
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‘Over 160 pages of Phone and i0S 15 guides, tips and tutorials
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Discover new uses and functionalty with step-by-step guides

Essential tutorials and insider tips for every i0 16 app

You navigate the Internet in Safari using hyperlinks, or simply
links’. A link can be a piece of underlined text, a picture, a button
or simply an area of the screen. To open a link you'll need to
move the mouse pointer over it and click. When the pointer is

over a link, it's replaced by a hand. or Open in New Window.
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Clicking a link takes you to a new page or opens a new window
based on what you've just clicked. If you don’t want to navigate
away from the page that you're currently on, right-click or Ctrl-click
on the link and from the pop-up menu, choose Open in New Tab



Add Tools to the Toolbar

@ Safari File Edit View History Bookmarks Window Help
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Customise Toolbar...
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Reload Page
Translation
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Zoom In
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Right-click or Ctrl-click on the toolbar and select

Customise Toolbar; or click the View menu and select the
option from there. A window slides down. To add a button to the
toolbar, simply drag it from the selection in the window onto the
Toolbar within the Flexible Space sections.

. 0]
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Repeat this with as many tools as you need. When

you're finished, click Done. To remove a tool from the
toolbar, simply drag it out of the toolbar, release and it
vanishes. To reset the tools to how they were originally
displayed, drag the default set of tools onto the Toolbar.

Status, Favourite & Tab Bars

v Always Show Toolbar in Full Screen
Customise Toolbar...

| & bdmpublications.co|

v Always Show Tab Bar § Electronics, Cars, Fashion, Collec|
Show Status Bar
m Bl_ Show Sidebar
" Show Bookmarks Sidebar

Show Reading List Sidebar

Guidebooks ~ BDM Learning

Show Reader
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Show Tab Overview

Show Downloads

Stop.
E Reload Page

Translation

Actual Size

You can show or hide the Tab, Favourites and/or Status Bar (a
strip along the bottom of the window showing the full URL) by
clicking the View option in the menu bar atop the screen, and
selecting the option in question.

’ Safari 1

Pinned Sites.
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Arrange Tabs By

World leading tech
guide publishers

If your tab bar isn’'t showing, go to the View menu and select
the Always Show Tab Bar option near the top. Now open the
site you intend to pin and right or ctrl-click on its tab. From
the pop-up menu, select the Pin Tab option.
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The site gets a small tab in the left-hand side of the tabs
bar. This is always in place, ready for you to click on it and
open the site. You can pin multiple sites in this way. They all
appear as small tabs, showing a symbol or letter.

& bdmp

Unpin Tab s, Cars, Fashion, Collectibles &... )

About Contact Offers Duplicate Tab Account Help

Close Tab

Wat Black Dog Media

Buy Guidebooks ~  BD

E Millions of Readers Worldwide =) Easy & Sec

To remove a site’s pinned tab, right-click or Ctrl-click on it and
from the pop-up menu, select Unpin Tab. The previously
pinned tab then becomes a regular tab. You can reorder your
pinned tabs by dragging them within the tabs bar.
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Bookmarks and Reading List

@ Safari File Edit View History Bookmarks Window Help

G ©
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ece @M -
6 v B N

<

& apple.com

) Electronics, Cars, Fashion, Col.

- |

You can save a website you're likely to return to often as

a Bookmark. A site you're interested in but don't have
time to read can be put on your Reading List. Both options are
available from the Share icon in the toolbar.

iPhone 13 Pro

A Roscus, e

o % Phone 13 Pro and iPhone 13 P. @ FElectronics, Cars, Fashion, C W Wikipedia

e 13 Pro Tech Specs

Add this page to:
B35 Useful Apple Sites. (<]

iPhone 13 Pro and iPhone 13 Pro Max - Apple (UK)

concel  (EED

When adding a bookmark, a pop-up window appears.

You can add a custom title for the website you're saving,
plus there’s an optional description field and a pull-down menu
that lets you add your site one of your bookmark folders.
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3 To access your Bookmarks and Reading List, open the
sidebar and click on the option, found under Collected
Links. Click a site to open it. In the Bookmarks sidebar, as shown,
you can right/Ctrl click and add a new folder if you wish.

The Start Page.

@ Safari  File Edit View History

Bookmarks  Window  Help ® 0
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iPhone 13 Pro
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iPhone 13 Pro and 13
Pro Max. Huge.

Fenty Beauty: How
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In the Reading List, drag a site left to save it for offline

reading or to delete it. The right/Ctrl click menu has an
option to remove/delete a site from either list. Click the small
chevron, top left, to return to the regular sidebar.
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© Video Games

T Asple Phone

e Shared with You

i

Start Page gives you a window full of useful shortcuts to your
most frequently visited sites alongside its default choices. Click
on the URL field at the top of the browser or in the Bookmarks
menu. Select, Show Start Page to access a window showing a
grid view of website icons, along with those you've visited most
recently and the default links to other sites.
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To add a site, click the URL field to open the Start Page and
drag the URL into it. You can drag sites and folders into this
window from your Bookmarks too. Drag icons around the Start
Page to reorder them, or drag out of it to remove them. Scroll
up for Siri suggestions, Frequently Visited and more. Click a
Show More/Less link to expand/contract a category.



Tab Groups
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1 Safari now lets you save groups of tabs. You can then
open a group of tabs, temporarily closing what's open at
the moment. Open the sidebar, then tap the New Tab Group
icon in the top-right of the sidebar for a menu.

[ Safari R

g D wow g
o

From the menu, you can make a group from all the tabs

you currently have open, or start a new, empty group
and then add tabs to it. We'll do the latter here. Either way, you
get to name the new tab group. Press Return when done.
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2 With your new tab group open (see the highlight in the
sidebar), tap the + icon (top right) to open a new tab,
then navigate to the site you wish to save in the tab group. Do
this as many times as you like to fill your tab group.

The Tabs Audio Indicator

Use the sidebar to switch between saved groups of tabs

and the tabs you have open on your Mac. Tap a tab
group and then tap the icon to its right to see the tabs as
thumbnails. Tab Groups are synced across your Apple gear.
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@ Spider-Man: Into the Spidervers...f Faith" - Art of the Scene - IGN

3 A Guided Tour of iPhone 13 & iPhone 13 Pro | Apple - YouTube
s 12/5 00U+ m

Deutsch

\’ 2590 000+ Artikel
QU

If one of your Safari tabs is playing audio and you're not

sure which one, look for the tab with the speaker icon,
shown on its right. You can mute this sound by clicking on this
speaker icon. Click again to unmute.

If more than one tab is producing audio, right-click on

one of them for options to mute that tab, mute the others
that are making a sound or enter Picture in Picture mode to
watch the video in a floating screen.
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Safari’s Shield

& safari

File

Edit View History Bookmarks Window Help

@ beta.whsmith.co.uk

[ol)' "VHSmith

whsmith.co.uk
w 11 trackers prevented from
profiling you

SPEND £50! USE PROMQ|

S~ Al | Trackers on This Web Page VV—H Smlth

EsT.1792

bing.com
contentsquare.net
doubleclick.net
dwinl.com
facebook.com

facebook.net

1 Click the Shield icon which is found to the left of the URL
field for a report on what trackers Safari has prevented

from following you. Click the chevron to list them, and the " icon

for more information about site tracking and why websites do it.

Tailor Site Settings

v @ Photos

= -

! ® Private Relay: On

Turn Off.

Private Relay keeps your internet activity private and secure. It protects your Safari
14888 browsing with complete IP masking and web traffic encryption. It even protects you
when using apps, preventing ISPs from profiling you.
Qq

IP Address Location:

You can keep using your general IP address location so that websites can provide
local content in Safari, or you can choose to use a broader IP address location in your
country and time zone.

© Maintain General Location
Use Courtry and Time Zone

= s —

© MaiDesk Pro 1P

[ BNOSBOmeSiPa= ICloud Storage: 50 GB (20.08 GB Avaliable)

If you have a paid-for iCloud subscription you can turn

on Private Relay, which prevents websites from viewing
your IP address. To turn it on and off, go to System Preferences
> Apple ID and under Private Relay, click the Options button.

Safari  File Edit View History Bookmarks Window Help ® © %
About Safari
Safari Extensions...
P D
Preferences... o 0 bbe.co.uk

blcy Report.. | W Black Dog Media

Settings for bbc.co.uk When visiting bbc.co.uk:
m il
Clear History... Use Reader when available
Enable content blockers
Services >
Hide Safari Page Zoom: 100% . R
Hide Othe Auto-Play: Allow All Auto-Play
i Pop-up Windows: Block and Notify
= | »
A

) o usic §

Quit Safari Camera: Ask

Microphone: Ask
Screen Sharing: Ask
Location: Ask

Listen Live

1 There’s a number of useful tools for tailoring your
experience on a per-site basis. Open the website and in
the Safari menu, select Settings for [the website]. You can
enable or disable content blockers, go straight to Reader View,
change the page zoom, stop auto-playing videos and more.

The Reader View.

@ Safari File Edit View History Bookmarks Window Help ® 9

@ ©

Wt Black Dog Media

bbe.co.uk

When visiting bbc.co.uk: Pl

UseReade 50% Ible
Enablecot 75% 3
85%

Page Zoon v 100%

Let us know you agree
to cookies

[B|B] © 120 0sbome

Auto-Pla 150, Auto-Play v

(\ (\ Pop-up Window  1oc0. | Notify ]
SouNnDS comer BEEE
175%

Microphont
Screen Sharin)  200%
Locatiol  250%

Listen Live

Page Zoom and Auto-Play are set with pull-down menus

that appear when you click their current values. By default,
the Auto-Play function stops videos with sound automatically
playing but you can override this using the Auto-Play menu. These
settings are applied whenever you load that site.

Gafari Fle Edit View History Bookmarks Window Help

@ ©

& enwikipedia.org

W Aole inc. - Wikiped

7 _mm
e
) n Article  Tak

‘WIKIPEDIA

The Free Eneyclopedia

2 Notlogged i Tak Contrbutions. Graate accol

Read Viewsource View history | Search Wikipedia

From Wikipodia, th Coordnates: (g 37345 13
Fi on

ies, see Appio (disambiguation) § Organisations and companies.
mpany that spocializos in
Services. Apple Is the world's
\ 74.5 bilon in 2020) and, since g
January 2021, tho worid . As of 2021, Apple is the world's

fourthargest PG vendor by URTMSIEr=Tand fourth-largest smartphone

‘manutacturer."91" Itis one of the Big Five American information technology companies,

Apple Inc.

Hap along with Amazon, Google, Microsoft, and Facabook 12119114

|

o w, and Bonald Wawna in 107610 —

®@ 9 3 a $

View History Bookmarks Window Help

0~ < @ O (= Mo
Use Reader Automatically on “en.wikipedia.org”
B2 O A4 T Reader Websites Preferences. . ‘
& & Not logged in Talk Conl

Read View source View history | Sear

K
5 Article  Talk

piA  Apple Inc.

lopedia ) :
S From Wikipedia, the free encyclopedia Coord
(Redirected from Apple inc)

“Apple (company)* redirects here. For other see Apple (di ion) § O and|
Apple Inc. is an American

consumer

company that specializes in
computer software, and online services. Apple is the world's

The Reader View isn’t available on every web page. Look for
this icon that appears in the left-hand side of the URL field.
When it's there, you can click it to access the Reader View, for
a simpler (and far more easily printed) page.
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Reader View can be configured to your own requirements.
Right or Ctrl-click on the Reader View icon and you get a menu
from where you can opt to always use Reader View on the
current site, or open the Reader View preferences.



Getting More from Safari

[ Safari | &

@ Safari File Edit View History Bookmarks Window Help ®
oo @ @

Private Browsing Enabled
Safari will keep your browsing history private for all tabs in this window. After you close this window, Safari won't remember the pas
AutoFill information.

Favourites
.‘ " /{ m . n
ou https:// Apple. Rescue, Top Tech Latest Free People's
German develop... (United... Rehome... Confere... Stuff ... Pension
]~ X 2
\VY =] = )

Private Browsing

Private Browsing lets you browse the Internet without adding
tracking cookies or recording where you've been in your history:.
Activate Privacy Mode by selecting New Private Window in the
File menu. In a private window, the URL field is darkened.

Passwords

9 a 8 & ®

Passwords  Sesrch

kL

Passwords Are Locked

To unlock passwords, enter the password for
the user “lan Osbome*.

rtor puisword

Stored Passwords

You can access any stored login credentials from a website by
entering Safari > Preferences, then clicking on the Passwords
section. You need to enter your admin password to unlock
them. You can see if passwords have been compromised, and
change them from this window.

iPhone 13 and iPhone 13 mini... — https://u

® 8
d @ Here's Why the Apple Watch Only Works with Official Chargers |...

Q iPhone s Ultimate Photos

Apple unveils iPhone 13 Pro and iPhone 13 P... apple.com/newsroo...

[EREPIERN TERI v e ) Apple introduces iPhone 13 and IPhione 13 m..._ apple cominewsioo.—  Jmm RTARSY MRS 1)
iPhone 13 Pro and 13 Pro Max - Technical Sp...  apple.conyukfiphon.
iPhone 13 and iPhone 13 mini - Technical Sp...
iPhone 13 Pro cameras - Google Search

apple.comyiphone-1.

‘google.com/search?.

Bookmarks and History
iPhone - Apple

Iphone 13 High Res Stock Images | Shutterst...
iPhone & i0S 15 Definitive Guide - Digital Do...
iPhone 13: Why it's Actually An iPhone 125 ...

apple.com/iphone/

shutterstock.com/ho...

bdmpublications.co.

Safari File Edit View History Bookmarks Window Help

About Safari
Safari Extensions...

Preferences.. # bdmpublications.com

Privacy Report...
Settings for bdmpublications.com

Clear History...

Services >

uides

My Account  Help

Buy Guidebooks BDM Learning Bun|
Hide Safari
Hide Others
Shov

@ Easy & Secure Online Check|

Quit Safari

Clear Browsing History

In the Safari menu, there’s an option Clear History, which erases
your browsing history and website data. Hold Alt while you select it
to delete your browsing history, but not website data. In the pop-up,
choose whether to delete all or recent history with the pull-down.

Search

= § Q 8 06 & $H K

Autofill Passwords Search Securlty Privacy

General  Tabs

Websites Extensions  Advanced

Search engine: Google (]

Include search engine suggestions

Smart Search Field:  Include Safari Suggestions
@ Enable Quick Website Search  Manage Websites...
Preload Top Hit in the background
Show Favourites ?

Change Your Search Engine

To change the search engine Safari uses by default, select
Preferences from the Safari menu. Click on the Search tab
and from the pull-down select the search engine you want
to use. The sites on offer are Google, Yahoo, Bing,
DuckDuckGo and Ecosia.

Satari Extansions

et St ensons Gramar olcntothe escue
& Arcade

B Create

9 Work

< piay

2 Develon
£ Catogories
@ Updates

Browse Better

TPassword 7 - Password Manager

TBlocker: Ad Blocker & Privacy.
oer o

Integrated Spotlight Search

Spotlight search is a tightly integrated feature of macOS,
including Safari. From the search bar you can find links to
web pages, bookmarks and browsing history; simply by
typing a search term. Click on one of the responses to open
that particular website in your browser.

Safari Extensions

You can add great extensions to Safari to expand its
functionality and speed up your workflow. Open Safari's
Preferences window (Safari > Preferences) and select
Extensions. Click on the More Extensions button to access the
App Store’s extensions page, from where they can be installed.
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Mai

Send & Receive Emaill

Monterey has a great bundled email application, so sending and receiving
emails is as easy as typing a message and clicking a button. Here’s how to

get the most from the Mail app.

This is the sidebar, which lets you select

mailboxes, see emails from VIP senders
or those which you've flagged, and more. You
can resize and even close this sidebar by
clicking and dragging the divider between
this and your emails list.

The list of emails contained in the
currently selected mailbox, in this
case, All Mailboxes. The number of emails in
the box, and the number of unread emails,
are shown. You can resize this column by
clicking and dragging its left or right edge.

Click this circular icon to toggle
between showing all emails and only
unread emails.

This button downloads new emails. You
can set your Mail app to check
automatically but this button does so manually.

When you want to write a new email
from scratch, click on this button to
open a blank one.

This button archives the selected
message. Very useful if you want to
make sure you don't delete it.

7 If you want to throw away the currently
selected email, click here to send it to
the Trash folder.

This button moves the selected email to
your junk mail folder. Use it to help the
Mail app identify ‘spam’, which is junk emails.

This button lets you reply to the

currently selected email, with the reply
going to its sender only.
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& Mail File

v £ All Inboxes
£ iCloud

17

69 Pipex

v VIPs

Jon White

23 [=] Flagged
> </ All Sent

Edit

James Gale

37

E Karl Linstead

Mark Ayshford

Martin Smith

View  Mailbox

All Inboxes
8,706 messages, 37 unread

3 Inbox
[ Drafts
</ Sent
& Junk
W Bin

& Archive

3 Inbox

[3 Drafts

37

Checking for Mail... 25

Message Format
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lan Osborne Inbox -.. 10:07 am
Essential AppleUser Magazine Iss...
Hey, look what's out? | can't wait to

read it. B m
Microsoft Sto nbo.. 9:44 am

Be in with a chance of winning £1...

Buy an Xbox Series S today

Games That... Inb... 9:31am
[New post] Retro
f ng posted: "1991 Core Desigr

s: Commodore Amiga and

The Independ... Inb..

Grow up and tackle climate crisis,...

7:53 am

The Independen
Headlines email

Morning

ew online

eBay nbox - Pipex 3:47 am
Watch Replacement TV Remot... f...

ly with Watch List
Be one of the

You'll know instz
Did the price droy
Duolingo Inbox - Pi
Hi lan Osborne! That 534 day str...

Learning a language requires

Yesterday

practice every day
Fanatical Bu... Inb Yesterday

Pick from 22 Steam games! NEW...

1€S and coupons

Readly Inbox - iCloud Yesterday
New issues of your favourite mag...

ue of MacFormat is

nat Click here to open

Window

s
X U©

Help

7]

lan Osbo
Essential A

ey
m To: lan Os

Hey, look what's oL

ﬁ




Use this button to reply

to the sender of the
currently selected email, but
also to everyone else that

colour. Click the chevron
next to the flag for a
pull-down menu that lets you
select a different flag.

Information about what

mailbox the open email
is in, what time it was
received and the paper clip

received it. shows it has attachments.
Use this button to
silence notifications on

threads that are sending you

too many alerts.

If you want to forward

an email to a third party,
that is, not the person who
sent it to you, use this button. field here.

This pull-down menu is

another way of moving
an email into another mailbox
or folder.

Click the flag to mark
the currently open
email with a flag of this

These are email
17

® Q ® & 8 © Wed22Sep 10:29am
617 3889 108118120813 muug14)
=] @ QA e w ¥ @ 3 Move to...
sborne [=) :_‘.,,Km‘,: an

ial AppleUser Magazine Issue 30 is here!

20| 1

s out? | can’t wait to read it.

1 Osborne

MacBooks ¢ iPad ¢ Mac ¢ iPod touch * & Watch « & TV

SSENTIA L L

ISSUE 30 | OCTOBER 2021

inboxes and as you
can see, we have two email

To search for a specific
subject, person or word/
phrase in your emails, use the

.

[ mail |5

accounts set up in Mail;
however, you can have more
or fewer if you prefer.

Your emails appear

here. Unread emails
are shown with a blue dot to
the left. Click on an email to
open it in the main window.

If the email's sender is

in your Contacts and
has a picture, it appears
here. If not, it’s just a grey
circle with an initial in it. To
the right is information about
who sent and received the
open email, and its subject.

Hover over the top of

the open email and
the icons numbered 7-11 are
repeated. Their functionality
is the same.

If the open email has

attachments, click here
for a pull-down listing them all,
from where you can select and
open them.

If you've identified

senders as VIPs, they're
listed here. Click ‘VIPs’ to open
and close this section, and
click on a VIP name to see
emails from that person.

Here you can access

emails you've flagged,
or those you have sent from
your email accounts.

Various other mailboxes
associated with the
accounts you've set up in Mail.

When new emails are
downloading or
sending, it says so here.

The Column Layout.

To use the old-school,
column-based layout, in
the View menu, select
Use Column Layout.
Repeat this step to revert
to the modern layout.
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Sending a New Email

- ) -~

ages, 34 unread

o] B W

sborne Inbox -... 10:07 am lan Osborne

ial AppleUser Magazine Iss... Essential AppleUser Mag
ok what's out? | can't wait i To:
. B

lan Osborne

soft Store
ith a chance of winning
Xbox Series S today

Inbo...

Hey, look what’s out? | can’t wait t

s That... Inb...
post] Retro

9:31am

1 Here we show you how to open a new, blank email, write
a message and send it to a given email address using
the Mac’s Mail app. To open a new email, first click on the
Compose New Message icon in the toolbar on top of the
window; the one that looks like a pen writing on paper.

eoe < B

To: James Gale~ Mark Ayshford v
Cc: Martin Smithv Karl Linstead v
Subject: Things to discuss|

From: lan Osborne — atsk94@dsl.pipex.com

W Mailbox Message Format Window  Help

© © s a s = m & =

eve v B- é A @ @-

To James Galev Mark Ayshford~

Ce Martin Smith= Karl Linstead~ ®

om: lan Osborne - atsk94@dsl.pipex.com signature:  None e

To send someone an emalil, type their email address into

the box marked To:. To also send it to someone else,
add their email address in the Cc: box. Add multiple email
addresses in either box, separated by commas, to send the
same message to a group of people.

ese I B~ @ A @ @~
T2 James Gale~ Mark Ayshford -

Ce: Martin Smith+ Karl Linstead

Subject: Things to discuss

From: lan Osborne - atsk94@dsl.pipex.com e: None [2]

Hi folks,

Afew things we need 1o discuss regarding the next project.
* Furniture for the new office building.

* Finalising the

* Talk to the contracior about our deadiines.

* Make suro the staff know what's expocted of them.

Does anyone have anything to add to this?

Regards,
lan Osborne

It's always a good idea to put something in the subject

line, even if it's just ‘Hello!’. Type the body of your
message in the large space below. An email can be as long
as you like and you can use different fonts, colours and
sizes if you really feel the need.

Customising Mail.

® WAl e EGl View Malbor Messege Fomal Window e ® 9 3+ as =

0 Generat
& @ Aa 00 F H B L O

Dofault email reader: [ Mail -]

Check fornew messages: | Automaticall e

New messages sound:  New Messages Sound %)

Piay sounds for other mail actions.

Dock uvead count: nbox Oy e

Now message notfcaions:nbox Only )

Downioads folder: 35 Downloads @
Remove unedited downioads:  After Message s Deleted

Archive or delete muted messages

Automaticall try sending later f outgoing server s unavaiiable
Prefer opening messages in Spit View when In fullscreen
When searching all maitbaxes, include results from:

&in

Junk

You can customise your Mail app by opening it and, in the Mail
pull-down menu, selecting Preferences. Under the General tab,
you can set an interval to check for new messages, decide
where downloaded attachments go and more.
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Once you've finished typing your letter, click the Send

button in the top left corner of the email panel to send it
on its way. Email is usually sent very quickly, and your
addressee should receive it within a couple of minutes, as long
as there are no issues with their connection or provider.

Fonts & Colours
& @ W Aa oo [ S B

ts JunkMall Fonts& Colours Viewing Composing Signatures  Rules

Message list font System Font Regular 11 Select.

Message font: Helvetica 12 Select...
Fixed-width font: Menlo Regular 11 Select

Use fixed-width font for plain text messages

Colour quoted text
[ Purple
[ Teal
[ Green

Level One

2]
8 ovel Two

| Level Three

The Fonts & Colours tab lets you change the fonts and text
size used with incoming emails and change the colours of
quoted text. Explore the Mail preferences and set up how you
choose, but be careful with the server settings.



Receiving Email.

When you receive an email in your inbox, this is how
you open and read it using the macOS Mail app.

9 Games That Weren't
w [New post] Retro
To: lan Osborn

[nes Gale New post on Games That Weren't

White

eBay \bos - Pipex 0 =
Watch Replacement TV Remt. AR
1991 Core Design Platforms: Commodore Amiga an
recent post on Gyber Fight, comes yet another 3D

Retro. A title being developed for Core Design by St
nt b s Simon Phipps (artwork). No doubt with a bit of inspir

| Linstead Retro
rk Ayshford i
rtin Smith.
Duolingo
ed Hi an Osbornel That 534 day sir.
langue

Fanatical Bu... Read more of this post

Pick from 22 Steam games! NEW.

tgasking

Faviews | URL: hlps:/wp meis40iz-rehio

Once you've set up your email account, you can send
and receive email. As soon as you launch Mail, it
connects to your email service and collect any email that
is waiting for you. These messages are shown as a list in
your Inbox. Click on one and it’s displayed on the right.

®@ ® O B U ®

Games That Weren't
ew post] Retro

hes That...  Inb...
) post] Retro

King posted: "1991 Core Design
lorms: Commodore Amiga and...

9:31am

lan Osborne

Independ... Inb 7:53 am
up and tackle climate crisis, ...

Al + ~

While Mail is running, it periodically checks the server for
new messages. You can also prompt Mail to look at the
server immediately by clicking the button in the top left of
the screen that looks like an envelope.

Adding Attachments.

and 12 Pro manuals, price free! We brand to

P run promotions across the socials etc, free

o do is have people send us a pic of them posing
‘party and they get the magazine for free?

Cheers

Replying to & Forwarding Email

If someone you know sends you an email, you'll probably want
to reply to them. Simply click on the email so you are viewing
the text of it, then at the top of the screen you'll find a row of
three buttons, as you can see here.

The leftmost one has a single left-pointing arrow on it. This
is the Reply button. If you click on this you'll see a window

pop up that looks a lot like the window for a new email, but it will
have the responder’s email address already in the To: box.

Next to the Reply button is a similar button with two left

arrows on it. This is the Reply All button; use this with
extreme care. If you have been sent an email that has also
been sent to a number of other recipients, hitting Reply All will
send your reply to everyone who received the original mail.
Obviously if your reply was meant to be private this is a very
bad idea, and has got many people into trouble.

The rightmost button of these three is the Forward button,
which is used to send an email you've received to
another recipient. Forwarding emails is another thing that
requires care; make sure that you don't accidentally send private
information to someone who was not meant to receive it.

Almost any type of file can be attached and sent over the Internet along with your email.

eve ¥ B [~

&é Aa @
f Signature:  None e

To add an attachment, first start an email (or reply to one
you received), and then click on the button bearing the
picture of a paperclip, at the top right of the email panel. This
will open a Finder window, allowing you to navigate to the
file or files that you want to send. Select the ones you want,
then click Choose File to attach them.

James Gale~

ct: Look at this!

m: lan Osborne - atsk94@dsl.pipex.com

ject: Look at this!

ian Osborne - atsk94@dsl.pipex.com

None 2]

. Medium

Open Attachment
Open With >
Quick Look Attachment

Save Attachment

Save to Downloads Folder
Share

View as Icon

Copy Image

>

Insert from iPhone or iPad >

In Mail, pictures you'’ve included as attachments are shown
in the body of the email for convenient viewing. This means
you can turn your email into a mini-illustrated article if you
want; or, if you don’t want to display it as an attachment,
right-click on it and from the contextual menu, choose View
as Icon. It can still be opened by the recipient.
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The Mail Markup Feature

) T T W & ¥ O W

Format —Window e (o]

ety

The Markup feature lets you add notes and scribbles to

pictures that are attached to an email before you send it. To
begin using the Mail app’s Markup feature, start writing an email
and attach a photo to it in the usual way:.

None

Medium

Click on the attached image, and then click on the

small chevron that appears in the upper right corner of
the photograph. Select the Markup option to open the Mail
app’s Markup feature. You can also use certain third-party
apps to edit photos further this way.

oct. Three hikers

om: lan Osborne - atsk94@dsl pipex.com

3 You can now use the interface that appears to add text,
drawings, or a range of shapes and symbols directly
onto the photo, in the email environment. When you're
finished, click the Done button and either mark up more
pictures or send your email as normal.
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Move to...

Highlight or open an email. In the top-right corner there’s
a pull-down menu marked ‘Move to...” in the toolbar. If
your Mail window is small, you might have to click on a
chevron and select it from a menu. This lets you move it
to one of your folders including Trash, Junk, and folders
you’ve set up yourself.

Wed 22 Sep 11:41 am

< s & icloud |
[ All Drafts & Pipex
<7 All Sent

@ AllBins

& Junk

B Archive

azine Issue 30 is here!

B Archive
3 Inbox
[ Drafts

* jPad * Mac * iPod touch » & Watc

100% INDEPENDENT
\ A

Show Only Unread Messages.

You can hide emails you've already read by clicking this
icon. Now only unread messages are shown. Click it again
to show all your emails once more. It’s great for finding
emails that you received a while ago but haven’t seen yet.

All Inboxes

= ® Etsy
v B3 All Inboxes Reset Your Password
& iCloud

) Pipex

@ lain Rob Wr...

v VIPs More puppa pics ¥

James Gale
Jon White

® Amazon.co....

Karl Linstead Kindle Daily Deal: Boo)

Mark Ayshford

Flagging an Email.

To mark an email with a flag, highlighting it for later reference,
click on the Flag pull-down and choose a colour. You can add
more than one flag to a single email. To remove them again,
choose Clear Flag. The ‘Flagged’ option in the side bar
shows emails you've marked.

Orange
M Red
M Purple
™ Blue
Yellow
™ Green

Re. Novel View in browser

Clear Flag
Toggle Flag




Mail Drop.

If you need to send large attachments via email,
the Mail Drop feature is very useful.

a3

Would you like to send this
attachment using Mail Drop?

0 100 large to

Use Mail Drop

Try Sending in Emall
Cancel

Don't ask again for this account

If an attachment you wish to email is too large for a
regular email, it's stored on Apple’s server and offered
as a download instead. Depending on whether the
recipient is using Mail, the attachment could appear as a
download link or as thumbnails.

Save All (104 GE

« 1n the City 4jpg
On the Beach 03jog

- Coronavirus 4Jpg

- Onthe Beach 04pg

- Onthe Beach 05100 o
Rock Festival 0205

- Rock Festival 12/pg

- Rock Festival 06.pg.
Coronavirus 3jpg
In the Woods 3jog

- Family Meal 0609

- Family Meal 1208
On the Beach 13jpg

Here, we received huge photos, which are displayed as
thumbnails. You can download them all by hovering over the
email and clicking on the paperclip as shown. They're kept
on Apple’s server for a month from the date they were sent.

Mail in Full Screen Mode.

IZ) =

Searching Your Emails

» | Q_ Pictures ©

63 Subject contains: Pictures

64 Pictures again
54 More sweep pictures

549 Capture and create perfect pictures!

& Attachment name contains: Pictures

Click the magnifying glass icon and type your search

term into the search field. Suggestions are offered for
items such as people, subjects and attachments; emails that
meet your search requirements are shown in the email list.

®@ © 3 Q 8 T wa & 2 © Wed22Sep 12:25pm

»| Q Pictures (<]
v Subject J
Entire Message

After clicking on one of the suggested items, you can

adjust your search by clicking the first word in the field
and choosing a new option, as shown here, or even adding a
second search term for more advanced searches.

The Mail app’s full-screen mode works in a different way to other apps. Here’s a guide on how to use this useful feature.

amazona.

MONK KIDD'
8

The indepe

Leam more

Job alerts

AMP Limited

Autumn Sale

Shop now

Constable
{@iihe Dar

- el 7d

Writing or replying to an email when the Mail app is in full
screen mode involves working in a split screen view. Click on
the green gumdrop in the top left corner of the Mail app
window to take the app into full screen mode.

Tain Rob Wr. Amazon.co.uk

Amazon.co.

Kt Daly Deat Books from 99, an Osborne - atzk94@dsl pipex.com Non

lan Osborne,

The indepe.

Learn more
Job slerts |

AMP Limited

Autumn Sale

Shop now

Bay Soller

Start a new email or reply to one. The screen is split, with your
outgoing email shown on the right. Drag the dividing line left or
right to resize the windows. The email’s gumdrops are shown
by dragging your pointer to the top of the screen.
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Using Mail Signatures.

You can add a signature to your emails, that is, a short
piece of text that’s at the foot of every email you send.

Signatures
Aa 00 @ O B &
& Al Signatures  Work Signature Regards.
o Cowd G i sz
- e o ooy
@ s oo e
oot okl
e
excranse
@ roxee
@
@™

Werkeg rom
15 Somarset Avenue
Exmer

Devon
Baae

9 Always match my defaut message font

Choose Signature:  None

Place signature above quoted text

A signature is a piece of text that you can add to the foot of
your email automatically. To set one or more up, open Mail
Preferences (from the Mail menu), click on Signatures in the
top bar and then on the account to which you wish to add a
signature in the accounts on the left. Click on the ‘+" button
under the middle column to add a signature.

ese < B~ @ Aa @ @~
James Gale -
ct: Update for project None
om: lan Osborne - atsk94@dsl.pipex.com LUENNEY / Work Signature |
- Edit Signatures

The schedule is on target. The project should be finished tomorrow.
Regards,

an Osbome

Group Editor, Apple Bookazines

Papercut Limited / Black Dog Media

Tel: 07893 129740

Email: ian@bdmpublications.com

‘www.bdmpublications.com

Working from home

You can click on the name of it in the middle column and
change it to anything you like, and write your chosen
signature in the right-hand column. It can be anything you
want. Now, when writing, forwarding, or replying to an
email, you can add or remove your signature using the
pull-down menu to the right of the From field.

Accessing Emojis.

James Gale~ Mark Ayshford -

Martin Smith= Karl Linstead =
Things to discuss
1an Osbarne - atsk94@ds pipex com
Hitoss,

Afow things wo noed 10 diccuss rogarding the noxd project.
s o e e ot

The Mail app has an emoji picker to use when writing an
email. Click on the smiley face in the toolbar and you get a
choice of emoji to add to your email. To add it, just click on
the one you want. Scroll up and down, or click the icons at
the bottom for more choices.
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More Mail Features
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| WANT YOU TO BE THE
To: lan Osborne,
Reply-To:

Copy Address

mergal - Add to VIPs
Block Contact

Attn: Sir/Madam New Email

A customer of ours who died nin¢ Add to Contacts 1leaving behind an estate/capital (
here where | work,
till date nobody has come forwan

Search for “Mr. James Morgan”
During the Bank private search for ine 1ate gentie man reiauves your name and email contact was among the fi
the same surname as the deceased who died intestate with no Will or next of kin. To maintain the level of secul
intentionally left out the final details.

Banking regulation/legislation demand that | notify the fiscal authorities after a statutory time period when dorm:
type are called in by the monetary regulatory bodies if nobody applies to claim the funds.| urge you to come for|
pmwde you with (ne delalls needed for you lo clalm the eslale/capl(al S0 (ha( Ican be grauly hy you in lhls way

Block Contact

To block a sender who sends you emails you don't wish to
receive, click on that person’s name in the incoming email and
select Block Contact. To stop blocked emails reaching your
inbox, in Mail Preferences, go to Junk Mail and click the Blocked
tab. Select ‘Move it to the Bin’ to send emails from blocked
senders straight to the bin.

R KN 2 M. N\ B Moeto. Q
Mute selected conversations
B Inbox - Pipex 17 September 2021 at 3:54 pm

IVE THANKS.123.188

l.com

unami tragedy in Indonesia leaving behind an estate/capital (US$20M) in a Bank

Mute Thread

If an email exchange is throwing up too many notifications, you
can mute it by clicking on the crossed-out bell in the toolbar. The
emails still arrive as usual, but, until you unmute it again, you
won't get notifications on delivery.

R O B 0 T Q& & » M. B BMowewo

(74 Microsoft Store =]
& e invith a chance of winning £125 to spend at Microsoft Store
To: lan Osborne

is message is from a mailing list. Unsubscribe

B® Microsoft

Unsubscribe

If an incoming email is from a mailing list, the Unsubscribe link
now appears right at the top of the email. Click the Unsubscribe
link to stop this mailing list from sending you emails in the future.



Home

Mail and Home App | L1 £

For the Smart Home

Apple’s HomeKit gave developers the means to control compatible household
gadgets from devices such as the Mac, iPhone, iPad and iPod touch. Your

connected home gear can be controlled under one application. You can set up
automations too, so multiple devices can be activated with a single instruction.

Edt Format View Window Help

1 Before you can make use of the Home app, you have to
add HomeKit compatible devices. You can only do this
from an iOS device, you can't use your Mac. There’s a list of
HomeKit compatible devices online at www.apple.co/2MFjhb3.

floe Edt Fomat View Window Help

Include in Favourites

When you've added one or more devices using your

iOS device, you can access them through Home on the
Mac. Right-click on a device’s window and select Settings and
you can change the room they’re assigned to.

3 Click the Automation tab and you can set timers, actions
and more. What they do depends on what kit you've
incorporated into your Home app. Click the + icon to add
automations or groups of automations (scenes).

For example, you can use the Home app to control
and configure speakers that are compatible with
HomeKit. Naturally, Apple’s own HomePod, pictured here,

fits the bill but there are plenty more.
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Music
Play Your Tunes

The Music app is great for enjoying all your sounds on the Mac. If you
subscribe to the Apple Music service, you can stream from over 70 million
tracks and numerous online radio stations. You can rip your CDs and store
them on your Mac, and you can also compile your own playlists.

The Music app is very similar
to the one found on the iPhone
or the iPad. If you already use
Music on a mobile device,

you shouldn’t have too many
problems getting started.

When you're using the Music
app, the top bar gives you
pull-down menus offering controls and
options. It's worthwhile familiarising

yourself with them.

Completion suggestions are

offered as you type, and results
can be limited to Apple Music, or your
on-Mac library, as you wish. Results
include artists, songs, albums and more.

These are, in turn, Shuffle Tracks,
Previous track, Play/Pause, Next
track, Repeat Play.

When you're playing music, the

album art, artist and title are
shown here. Click on the album art to
switch to the mini player, which shows
the album art and controls only and
takes up much less space on the
screen. The line under the track name
lets you scrub through the song.

Click and drag the dot, and move it
left and right to change the volume.

These three icons, in turn are;

wirelessly transmit your music to
Bluetooth headphones or speakers;
open a sidebar showing the lyrics to
the track that's currently playing; show
a sidebar giving a list of what's
playing next and your history; that is,
what you've played.
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Importing Your CDs into Music

»> bt 2Cellos

2Cellos

Time Artst
405 2cELL0S
215 2cELL0S
329 20ELL05
412 2cELL0S
329 2cELL08
350 2¢ELL0S
430 20ELL0S
312 2ELL0S

249 2CELLOS
342 206LL0S

Pop the CD into your Mac's CD drive. If it
doesn't have one, use an external optical

On the Silver Mountain
Ritchie Blackmore's Rainbow

Added Made for You
& Music ®Music

Wax Eclectic
from stone classics to indie
contemporaries.

lan Osborne’s Station

39O X © @ © 2 Q 8 T WAy K © Tue28Sep 7:57p

You see the track listing of the album
appear. The spinning circle indicates

a green tick next to a track tells you it has
already been copied successfully:

Once you've successfully
imported your album, don't
drive like Apple’s USB SuperDrive. Amessage  which track is currently being copied, while  forget to click on the Eject button in
pops up asking you if you want to import the
album into your iTunes library; click Yes.

the sidebar or the top-right so you can
store your CD away.

If you have an Apple Music

account, Listen Now is the main
page, offering suggestions of music you
might like and showing what you played
recently. Browse is great for finding new
music, and Radio gives access to
streaming stations.

This is the Listen Now page, your
gateway to the Apple Music
streaming service.

This is the gateway to your Music

social network. Click on it and you
can find out what sounds your friends
are listening to, and discover and enjoy
new music together.

These are the options for your
Library, that is, music you've
installed on your Mac. It can be arranged
into Artists, Albums, or Songs, and there
are sections for music you've recently

added and music videos.

At the top of the Listen Now page is

Top Picks, a series of playlists made
up of tracks chosen for you based on
previous plays, tunes you play a lot, themed
playlists, etc. Scroll left and right for more.

These are your playlists. The top

ones are Smart Playlists, which
add songs automatically according to
rules, and the lower ones are playlists you
build yourself.

This is a round-up of music you've

recently streamed. Scroll this page
up for more suggestions, again based
on previous listens.

Click this link to see a wider range
of music you've recently played.
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Signing Up for Apple Music

® Usten bow.
# Browe

Listen Now

Lose yourself in millions of songs.

© focenty Added
2 Arists
0 Abums

all & Music

&Music
Get 3 months of free music
sy

riire music lbrary on allyour devices, 3 months free, then

With an Apple Music account, you can stream from 70
million songs for a set monthly fee. To sign up for an
account, click on Listen Now in the left-hand sidebar. You can then

click Try it For Free to learn about and sign up to the service.

A pop-up window appears inviting you to subscribe as

an individual, for £9.99/$9.99/9.99 € after your free trial.
Click Try it For Free to do so, or See All Plans to choose a
Family or Student account

A |

Lis gl S
o .
5 g&j 4

Apple 1D:

Get 3 months of free music

3 You must then sign using to your Apple ID. Enter your
Apple ID’s email address, then your password, and then
click Sign In to proceed to the next step. If you've forgotten
your details, click the Forgot Apple ID or Password? link.

This Apple ID has not yet been
used with the App Store.

Plaas roview your account inormation

If you've not yet used your Apple ID on the App Store,

you have to ender payment information as shown. You
then follow the on-screen instructions regarding what kind of
music you like. When done, you're ready to start.

Changing or Cancelling Your Subscription

a Apple D Account

7 Som Settings

If you want to cancel your Apple Music subscription, first
1 of all, click Account in the top bar and select View My
Account. You're taken to your account page. Scroll down to
Subscriptions (under Settings) and click the Manage link
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On the next page, you're shown your active

subscriptions. Click on Apple Music’s Edit link, and on
the next page, you can change your subscription to a different
one (individual, family or yearly) or cancel it altogether.



Using Apple Music
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1% At Playtists

A Morissette Esse..

' Mison's music

Browse or search for the artist, album, or track to which you

want to listen. Here we're looking at an album. Click Play to
play it in its entirety, or Shuffle to play the tracks in a random order.
Tracks marked with an ‘E’ in a box have expilicit lyrics.

[ -G

Lana Del Rey
nore
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I e o iy
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Love *f Apple Wotch

= Classical and Jazz
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Play Next
Play Later
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Groupia Love (feat, ASAP Rocky) @

In My Feelings &

3 Click the three-dots icon on the right above the tracks for
a menu. Here you can add the album to a playlist or
create a new one, share it with your friends, like or dislike the
album as a whole, or create a station based on its artist.

oo [ 2 @ =
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Apple Music is all about helping you to find music you

enjoy listening to. When viewing an album, you can scroll
up and other titles by the artist in question are shown. Click on
one to open it in the main window, click the chevron to see more.

e e [ 3 @

Q Lstfor e °
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© Listen Now y ]
5 Browse
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2 rtars
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® Classical Music
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© Top 26 Most Payed
57 lanls Morissette Essa.

°F Aison's music

Music controls such as Play and Pause are found at the top

of the window. To identify tracks on an album you especially
like, hover the pointer to the left of a track, and click the heart that
appears. To cancel this, click on the heart a second time.

i Edt_ Sona View Contiols Accoumt  Window Help
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Each individual song also has a three-dots icon, offering

a similar menu that applies to that track alone. You can
also play the track by clicking the Play icon that appears when
you hover the mouse/trackpad pointer over it.

Q Lust for Life °
Browse
® tinimow
B New Music Daily Antidote
o Rocenty Added
# aris

£ Abume

New Music Dah{'

7 songs. ‘/

) Wausic Videos
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Your Go-To Playlists
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Most Playea
otte Esso,

7 Nison's music

7 Apple Watch

The Browse section offers tracks, artists, albums, and

playlists based on Apple Music editors’ choices and new
releases. It also offers current charts for various countries. The
Radio section lets you listen by station or genre, and more.
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N
s eWwWsS

Stories and Features

The News app is great for getting the important headlines as they break, from
news sources around the world. If you subscribe to Apple News+ you can
read a huge range of magazines and news publications on your Mac, and the
app is customisable too, so you'll always be in the know with world events.

Fle Edt View Window Help @ 0 QST @ L RO W

Video Games

i

NINTENDO

With Stealth Release UK and Europe until November

14

1 When you first open the News app, you see a sidebar
and a main window. The sidebar’s Today option is
selected, giving you a range of the day'’s top stories. Click on a

story to open it and read it in full.

Fle Edt View Window Help

Share 3
Now Window

New Tab D n

@@:rzs?-;acw.i

sky (S

Suggest More Staries Like This
‘Suggest Fawer Storles Like This
Save Story

Go to Channel
Follow Channel

Block Channel

Discover Channels..

Manage Notifications & Emal...
Manage Blocked Channels & Topics.
Manage Subscriptions..

(80 5ic Science Focus Magazine
& oaC History Magazine

3 Avple

o2 Asple Newsroom
= o

When you open a news story, if it has a video it can be

watched within the News app. In the File menu, there’s
an option to open the story in Safari. This takes you to the web
page from which the story was drawn.

&News Spotlight

N Today
B News+
0 Shared with You
R saved Stories

@ History

) Best of the Week
Health & Wellness
B cororavirus

B enoadger
{8 BuzzFeed UK
Aston Vila FC
[E3 Techrology
() s&C Science Focus Magazine
& 85C History Magazine

[ Asple

The Special Coverage section gives you a selection of

features chosen by Apple’s editors. If you find a story you
particularly like or dislike, use the thumbs up/down icons in the
top-right corner to improve future suggestions.
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Software
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In the sidebar section titled ‘Suggested by Siri’, you see

various subjects the News app thinks might interest you.
The stories work just like in the other sections; click one to
open it, click the chevron in the top-left to go back a page.
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In the File menu is an option called Discover Channels

& Topics. Click it for a range of news sources and
subjects for you to choose from. Click the plus sign in the
corner of any you especially like.
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Scroll down the window for more channels and topics.
Select as many or as few as you like. When you're
finished, click the Done button at the bottom. Your new sources

have been added to your sidebar.
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7 In the top left corner, you can see a search field. Enter
a search term for a subject or source you're interested
in and you're given a list of individual stories and channels,
which write about that subject.
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To save a story for later reading, select Save Story in the

File menu. Click Saved Stories in the sidebar to see the
pages you've saved. To go back to a story you've previously
read, click the History option in the sidebar.
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Scroll up the search results for a list of channels and

topics relating to the search. Click the plus sign to add
that channel or topic to your sidebar. To remove a channel or
topic, right-click on it and then select Unfollow.

Shared with You.

You can share News articles using the macOS Share
icon. If someone shares a story with you using
Messages, it appears in a sidebar category called
Shared with You. The person who shared it is indicated
under each shared story.
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Photos
- Manage Your Images

Monterey sees minor updates to the Photos
app. Memories has a new look, and you can
use Apple Music for background tunes. The
information panel is more comprehensive, and
facial recognition is improved. The interface

has been tweaked too.

Use this button to toggle

between regular thumbnails of
your photos, as seen here, and
square-shaped images that leave
little border.

This slider increases and
decreases the size of your
preview images.

Use these buttons to view your

photos arranged according to
the year, month, or day in which they
were taken.

Click here to see all your

photographs in the Photos
app, arranged as thumbnails.
Double-click on a thumbnail to
open a photo.

Select or open a photo and

then click the ‘i for the
information window. Here you can
review and edit where and when it
was taken, add captions and more.

The Share button lets you add

the picture to shared albums,
send it using Mail, AirDrop,
Messages and more, add it to Notes
or Reminders and even set a
desktop picture.

7 Choose a photo and click the

heart to identify a picture as
one of your favourites.
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Rotate the image 90%

anti-clockwise. Hold Alt to turn
it clockwise instead. Useful if a
picture that's been imported is not
the right way up.

The search field. Thanks to the

Photo app’s machine learning,
you can search for terms like ‘birthday’,
‘holiday’, ‘Christmas’ and more, to find
photos taken on these occasions.

Filter to display all pictures,

favourites, those you've edited,
only photos, only videos and
according to keywords.

Click to switch between

showing only your photos,
and both your own pics and those
shared with you.

These sidebar options

represent different ways of
viewing photos found in your library:.
Photos shows all your photos,
Memories arranges them into
groups, Favourites shows your best
pics, and Places groups them
according to where they were taken.
Recents, Imports and Recently
Deleted are self-explanatory.

These are the dates between
which the currently visible
pictures were taken and the locations.

@ Photos File Edit Image

e o
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2Jul-28

Library

Memories

People

Places m
Favourites
Recents
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O
&
&

Media Types
Shared Albums
My Albums

=) My Projects




The heart seen in the

corner here shows
you've identified this photo as
a favourite. Click the heart to
unfavourite it again.

Click here to arrange

and view your media
according to type, such as
Videos, Seffies, Live Photos,
Screenshots and more.

Click the chevron to

expand the Shared
Albums category. Photos
you've shared on iCloud are
listed in Activity, and Shared
Albums shows the albums in
which they were shared.
Hover over Shared Albums
and click the plus sign that
appears to the right to start a
new, shared album.

Months

Days )

All Photos

MacBook

17 These are your albums,
whether created by

yourself or put together

automatically by the app.

If you make a book,

calendar, card, print,
wall decor or slideshow based
on your photos, they appear
here. Apple no longer sells
prints, but you can get apps

© Mon 27 Sep 3:22 pm

‘ Photos | &

from the App Store for
third-party services. Hover over
My Projects and click the plus
sign to start a new project.

Your pictures, arranged

as thumbnails. Click on
one to open i, after which you
can swipe through them or
choose one from the preview
bar under an open photo.

Al
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The Editing Tools

1 Open a photo and click Edit. Use the Wand tool to
automatically enhance your pic or click the Edit button to
make manual adjustments. In Editing Mode, the Edit button
changes to ‘Done’. Click this when you've finished your edits.

Filters ® ©® Q

ADJUST

v :@: Light

Click a triangle in the sidebar to open a tool. The

Light, Colour and Black & White tools give you sliders
to increase or reduce the brightness and saturation or
switch to a monochrome image. Click the Options triangles
for more advanced editing tools.

In White Balance, select the feature to adjust with the

pull-down and use the slider to change it. Levels take
time to master. Hover your pointer over the graph and drag the
dots at the foot of the vertical lines to adjust.
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Edit With.

Right-click on an open photo and you get a sub-menu.
Hover over Edit With and, if you have third-party photo
editors on your Mac, you can open the photo in one of
them and then edit it using that app. Edits are carried
over into the Photos app.

3 Retouch removes unwanted objects from a picture.
Click the brush, then click and drag to paint over the
object. Let go and it's removed. Red Eye lets you paint out
red pupils caused by camera flash. You can adjust the
brush size with both tools.

In Curves, drag the diagonal line or the dots under the

right and left ends. A useful trick is to click on the left
dropper and click something black, then the right dropper and
click on something white. The Definition tool is another slider.



‘ Photos ' &

Selective Colour and Noise Reduction are sliders. The former 7 The Sharpen tool lets you sharpen pictures that are out of

lets you make adjustments to one colour at a time, using the focus. You can sharpen the edges, adjust the intensity and
pickers and sliders and Noise Reduction is for smoothing out more. The Vignette option lets you add an adjustable shadow to
speckles and other such imperfections in the photo. the edges of the photograph, as you can see we've done here.

Filters

Select the Filters tab and you can automatically add You can the Crop tab to rotate your photo if it isn't

an effect to your photo. Here we've gone for Vivid looking straight and also to crop it by dragging the
Warm but you can also set it cooler, make it monotone and corners into the photo. The Flip option in the sidebar mirrors
more. Choosing another filter overrides the last one. Choose the pic and Aspect lets you resize the photo according to
Original to remove all filters. an aspect ratio of your choice.

5 Window el T O ¥ AT T W & O WnuseE

Universal Tools.

All the options in Edit Mode have these three tools,
which appear when you hover over or open one of the
settings tools. The curly arrow reverses the last
adjustment you made. Auto makes an automatic
enhancement with that tool only and the tick in a circle
toggles the last edit you did on and off, so you can see
the difference it has made.

10 Edits made in the Photos app are non-destructive, so your

edits can be reversed. If you don't like your edits, click
Reset Adjustments in the bottom right corner to reverse the last
edit, or Revert to Original in the top left to erase all the edits.

www.pclpublications.com | 93



U MacBook’s Key Apps ’

Adding People

.
B e sssosmtomion.  csen et

1 Open a photo containing people and click the ‘i’ button
for the information window, and click the Add Faces
link. If Photos recognises faces in the picture, they're circled.
Click the tag under a circle to add that person’s name. Click
the Plus sign again to add further tags, which you can drag
into place as needed.

Projects

pecents. o Al - J
uports 5

fecently Deleted
fedia Types
fared Albums

y Albums

fay Projects.

1 You can still order prints and design books, calendars
and cards with Photos but Apple no longer sells them.
Instead, click ‘+" next to Projects and select the project you
want to start. Apps you have downloaded for the purpose are
shown, as is an App Store link taking you to extensions
offering these third-party services.

Memories

Click ‘People’ in the sidebar to see photos you've

identified by name. Click on a person to see all the
photos you have of them. If a photo doesn’'t contain that
person, right-click on it and select the option ‘X is not in this
photo’ to remove it. Scroll down and click Confirm Additional
Photos to check pics the app thinks are of that person.

tos extensions,

Photos for macOS lets you do
Using P! s, you car

Choose an extension offering the project you want and

install it. Then choose the pictures you want to import
into the project (hold cmd and click on them one by one),
then select the extension in the menu shown in the previous
step. You can then follow the instructions offered on-screen to
build and print your project.

ALISON

Over the Year

1 Click on Memories in the sidebar to show photos
grouped according to various factors, including time
and content. For example, a series of pictures taken over a
week in a certain location might be identified as a holiday.
Photos also picks your best shots too.
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Open a memory and hover over the picture at the top to

see a Play button. Click it for a slideshow. Hover over
the slideshow for controls. Click the cog to change the
background music. Right-click on a memory and you can
delete it or add it to your favourites.



Making New Albums

© Memories
@ People
& Places
© Favourites

© Recents

@ Imports

@ Recently Deleted

> () Media Types

> £ Shared Albums.

> (%) My Albums ®
© Album

@ Ssmart Album
B3 Folder

Projects

v () My Projects

1.203 Photos. 31 Videos

‘ Photos | &

Editing Photo Information

Adjust date and time of 1 selected photo

The original date and time of your photo is shown below. Adjust
10 the correct time.

Original
Adjusted: EIY08/2021, 11:45:42 am

ust 2021 11:45:42 ay

No camera information
No lens information
4813 x 3209

88MB

Time Zone: British Summer Time

Closest City: London - United Kingdom (-]

Cancel

1 On the pictures you want to make into an album,
cmd-click then hover over My Albums in the sidebar.
Click the plus sign that appears and choose whether to make
a regular album, a smart album or a folder from your pictures.

i _} [ -

Smart Album Name: | Untitled Smart Album

Match the following condition:

Photo is

LT e ] +
hidden

11 items matched edited cancel (IR

RAW

HOR

video
selfie

Live Photo
portrait
panorama
time-fapse

slo-mo

burst
screenshot leos
animated

v

If you choose a smart album, you can set rules. From

then on, any photo you add to your Photos app that
satisfies these rules is automatically added to your smart
album. Set its title in this window too.

im?bmmmnwm

s@za:?-;sowmmsni

My Albums. ®

@ Lvary
D Mamories
@ peosle
3 Praces

Fier By: Al ftems

© Favouries
@ Reconts
@ imports

@ Recerty Deleted

> 5 Mada Tye

>4 Sharnd Atbms

£ whototor 05,
) Retrospacs

£ waiipspers

Garden
8 Twier

2 Frends photo .. 8

3 Choose a regular album and you can give it a name.
The new album appears in your sidebar; click the
triangle next to My Albums to see them all. You can drag
photos onto this album to add them to it.

1 Open a photo and click on the ‘i icon in the top bar to
open the information window. You can add a title,
caption, key words and more here. You can also click on the

date and time that it was taken to open a second window.

:

Adjust date and time of 1 selected photo

The original cate and time of your photo is shown below Adjust
itto the correct time.

Original
Adjusted: 28/08ZTIER) 4:15:42pm o

The original photo wil be adjusted by 4 hours,
30 mintes

Time Zone: India Stancard Time
Closest City: Ahmedabad - India [

cancel (ST i

You can now close the information window. In the new
‘Adjust date and time’ window, you can change the

recorded date and time it was taken and the location, by clicking
another point on the map. Click the Adjust button when done.

iCloud Photos.

To find out how to use the iCloud Photos features in
Photos, take a look at our tutorial on iCloud and its
various features and functions.

° < Apple ID Q
% n Kaychain
© @, Private Relay
lan Osborne 5 Hide my email Options.
ian osborne@dsi pipexcom
@ iCloud Drive Options.
O o 0 @ eswisa
Name, Phone, Email @ oo

) password & Securty

7" calendars
(&) payment & shipping
Reminders
& iCloud Notes
Media & Purchases
) Ocsimica stac
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MacBook’s Key Apps \

2 Glossary of Mac and
Computing Terms

We've tried to keep this guide as jargon free as possible, but inevitably there
are some words and phrases that might still seem mysterious to the newcomer.
Where that’s the case, this glossary should help. If you're confused by a
technical term, take a look; you might just find the definition you need in here.

A

Accessibility: A series of tools
and features designed to
make an Apple device such
as the Mac and mobile
devices easier to use by
those with disabilities such
as vision or hearing
impairments. You can find
the Mac’s Accessibility

features and customise them

in System Preferences.
AirPlay: A protocol for

streaming sounds and video

from an Apple device to a

set of compatible speakers,

or a device such as an
Apple TV. It's wireless, and
easy to use as well.

AirTag: A small Bluetooth
device that can be tracked
using the Find My app. It's
used to locate property like
keys or luggage.

App: Short for ‘application’,
another name for a

computer software program.
Your Mac comes with a

selection of pre-installed

apps, and you can buy more

from the Mac App Store.
App Store: The App Store is

where you can download free

and paid programs to your
device using your Apple ID.

You can access it through the

application that comes
bundled with your Mac.

Apple ID: This is the email

address and password that

you have registered with
Apple. It's required to
access many online
applications on your Mac,
including iTunes, App
Store and Books.

Apple Menu: The menu that’s
opened by clicking on the
Apple icon in the left of the
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menu bar. It gives access to
system functions such as
Preferences, App Store,
Force Quit and more.

Apple Silicon: Apple’s new

series of processors, used
in the latest Macs. They
replace the older, Intel
CPUs previously used.

B

Bluetooth: Bluetooth is a

wireless technology used to
link and exchange data with
another compatible device. It
has a range of approximately
eight metres (25ft). The Mac
supports many Bluetooth
devices, including
headphones, keyboards and
fitness trackers.

Books: This is Apple’s eBook

application, which is
available for free from the
App Store and is also
bundled with recent
versions of macOS. It
handles the standard
electronic publishing
formats protected by
FairPlay DRM, and also
PDF documents. It was
introduced in 2010 along
with the iPad.

Browser: An app used to

access websites found on
the worldwide web. The
Mac comes with Apple’s
Safari browser preinstalled,
but others are available in
the App Store.

C

Calendar: This is one of Apple’s

preloaded apps. Use it to
keep track of events,
invitations, and reminders
on your Mac, iPhone, iPod
touch and iPad.

Closed Clamshell Mode: By
connecting your notebook
Mac to a display, an external
keyboard and a controller
such as a mouse or Magic
Trackpad, you can use it like
a desktop computer, with the
notebook closed.

D

Desktop: A computer that's
designed to be used on a desk
while plugged into the mains, at
home or in the office, as
opposed to a notebook or
laptop. Apple’s range of
desktop computers is the iMac,
the Mac mini and the Mac Pro.

Dock: The opaque strip at the
bottom of the screen. Apps
in the dock are easy to
access and open, and you
can customise it to best suit
your requirements. Apps
that are currently running
are also shown in the dock.

unless using mobile data.

Finder: The Finder is the Mac’s

user interface. It deals with
management of folders,
windows, menus and more.
Its feature set has grown over
the years, with recent
introductions including tabbed
Finder windows and tags.

Folders: A folder is a container

for a group of apps or files.
You can create one by
using Finder’s File menu, or
right-clicking on the desktop
and using the contextual
menu. You can drag items
into and out of a folder.

Force Quit: The act of forcing

an application to close
down, perhaps because it's
crashed or frozen. It's
achieved by right-clicking its
dock icon, or opening the
Apple menu and selecting
Force Quit. Unfortunately,
unsaved work will be lost.

G

Gestures: These are actions

E

Emoticon: A small drawing
used to augment a message
or text. Typically, these are
yellow faces showing a
variety of expressions.

F

Facebook: Currently the most
popular social networking
site on the Internet. Add
your Facebook account to
your list of Internet Accounts
in System Preferences and
you can share material
directly to it using the
macOS Share button.

FaceTime: You can make video
and audio calls to other Apple
devices using the FaceTime
app. These are made over
the Internet so are free

performed with your fingers
on the Mac’s trackpad.

You can use gestures on a
notebook trackpad, an
Apple Magic Trackpad or to
a limited extent, an Apple
Magic Mouse.

Gumdrops: A colloquial term for

the three coloured buttons
found in the top left corner of
an app or finder window.
They close the window (red),
minimise the window (yellow)
or switch to and from
full-screen mode (green)

H

HTML: Hypertext Markup

Language, the standard for
building websites, and a
cornerstone technology of
the worldwide web.



iCloud: The collective name for

Apple’s online services, it
replaced MobileMe and
integrates with all iOS/
iPadOS and macOS/0OS X
Mac computers.

iMessage: A text message
that's sent from one Apple
device to another.
iMessages use the Internet
rather than the mobile
phone network, so they're
sent free of charge from
iPhones and iPads.

iOS: Apple’s mobile operating
system. iOS is the software

that powers the iPhone, iPod

touch, iPad and Apple TV.

iPadOS: The latest operating
system used by the iPad. It
evolved from iOS.

iTunes: Apple’s abandoned
music playing software,
which was also used to
activate and sync iPads and
iOS devices. In macOS
Catalina, iTunes was
replaced by three new apps;
Music, TV and Podcasts.

L

LaunchPad: Found in the dock

represented by a rocket
icon, the LaunchPad is an
easy way of opening apps.
It resembles and behaves
like an iOS Home screen.

Lightning: The cable connection

used by modern iPads and
iPhones. It replaces the old
30-pin dock connectors, and
is used to charge these
mobile devices and sync
them with your Mac.

Location Services: Features
and software on your Mac
that pinpoint and use your
current location. The Maps
app is one example.

macOS: Formerly known as
0OS X, macOS is the
operating system on which
the Mac runs. The current
version of macOS is
Monterey. Like most recent
versions of macOS,

Monterey is a free upgrade.

Mail: The Mac’s bundled email
client. It can handle a wide
range of email accounts,
including Apple iCloud
accounts, Microsoft’'s and
Google’s mail services,
Yahoo email accounts and
those accounts that are
provided by your Internet

Service Provider. Third party

email apps are available.
Menu Bar: The macOS Menu

Bar sits atop the desktop, at

the top of the screen. On
the left are pull-down

menus, which vary
according to what app
you’re using. On the right
are menulets and controls,
along with info such as the
time and date.

Messages: One of Apple’s
built-in apps that handles
SMS text messages and
MMS multimedia messages.

MMS: Multimedia Messages
(MMS) supports images,
videos, sound, contact
cards, and location data.
Sent and received via the
Messages app on the Mac
to other Macs and mobile
cell phones.

Monitor: Also called a display,
this is an external screen
that's essential for Mac
minis and Mac Pros. You
can also add a monitor to
an iMac or notebook Mac
as a second or even
primary display.

Mouse: A controller used to
move your pointer around
your Mac'’s screen, and to
select options using the
mouse buttons. A mouse is
traditionally used with a
desktop computer such as
the iMac or Mac Pro, but if
you don't like trackpads,
you can use one with your
notebook too.

N

Notebook: A portable computer,
sometimes called a laptop.
Notebooks can be mains or
battery powered and have
their own built-in screen,
which folds down for
portability. Apple’s notebook
range includes of the
MacBook, MacBook Air and
MacBook Pro.

Notification Centre: A list of
recent notifications,
accessible by clicking on
the icon in the top-right
corner of the Mac’s desktop.

P

Photo Stream: Part of iCloud,
Photo Stream stores your
last thirty days or 1000
photos online and on your
iOS/iPadOS devices, and all
your photos on your Mac.

Photos: A bundled Mac
application that lets you
store, manage and edit your
photo collections and share
them with your other Apple
devices using iCloud.

Q

QuickTime: Apple’s 2D video
and graphics player, used to
play movies and other video
on your Mac.

[ Glossary of Mac and Computing Terms © ¢§

R

Retina Display: This is Apple’s

term for its high-resolution
screens. The pixels are so
small it's impossible to
distinguish between them at
a normal viewing distance,
making the on-screen images
very smooth and clear.

Right Click: On a two-button

mouse, a right-click is a click
with the right-hand mouse
button instead of the left. On
a Mac, with a trackpad or
Magic Mouse, a right-click is
achieved by holding the
Control button and clicking,
or setting up the device so a
two-fingered click or a click
on the right-hand side of the
Magic Mouse or Trackpad
delivers a right-click.

S

Safari: Apple’s web browser,

similar in function to
Microsoft Explorer or Google
Chrome. It's available for
both Macs and iOS/iPadOS
devices, and it lets you surf
the worldwide web.

SharePlay: A feature that lets

you share movies and
music while in a FaceTime
chat. All parties in the chat
enjoy the same media,
which is played in sync so
no one’s a few seconds
ahead or behind.

Siri: Apple’s voice activated

digital assistant. You can
give Siri spoken instructions
and the service replies by
giving you the information
you asked for; or by
activating the requested
Mac function.

SMS (Short Message Service):

Text messages sent from
the Messages app from a
Mac’s Messages app or
mobile device such as the
iPad or iPhone to other cell
mobile phones.

Tablet: A computer in a flat,

‘tablet’ form factor, such as
the iPad. While the iPad is the
most popular tablet computer,
other models are available.

Text Field: Any area of the

screen where you can add
text. For example, when
completing a web form, there
are text fields for things like
your name, address and
more. Tap on a text field to
bring up the cursor, so you
can start typing.

Thunderbolt: A high-speed

connectivity port offered on

recent Macs. A Thunderbolt
port can carry a video signal
as well as data, so it can be
used for an external display.

Touch Bar: The very latest
models of the MacBook Pro
replaces the function keys
with a touch-sensitive
screen which displays
functions and controls
according to the app or
feature you're currently
using. It also has a Touch
ID fingerprint scanner for
unlocking your Mac.

Trackpad: The controller device
used in notebook Macs. You
control your on-screen pointer
by dragging your finger across
the trackpad. Apple’s Magic
Trackpad is available for
desktop computers.

Twitter: One of the most
popular social networks
built around a follower/
following system rather
than friends, with
messages limited to 280
characters. There’s an
official Twitter app for the
Mac, and several third
party options for sending
Tweets too.

U

URL: Uniform Resource
Locator, the address used
to access a web page. For
example, Apple’s URL (its
website) is www.apple.com.

USB: (Universal Serial Bus) an
industry standard for
connecting computers and
peripherals introduced in the
mid-Nineties. The latest
version, USB-C, has a
similar plug to Thunderbolt
3, and is compatible with
Thunderbolt 3 ports.

\'/

VPN: (Virtual Private Network):
This provides secure access
over the Internet to private
networks, such as the network
at your company or school.

W

Wi-Fi: A wireless means of
getting onto the Internet or
connecting two devices. At
home, your Wi-Fi network is
established through your
router. Whilst away from
home, you might have
access to public Wi-Fi
networks like those offered
in coffee shops or libraries.

Y

YouTube: The Internet's most
popular video viewing and
sharing service. Owned by
Google, you can access
YouTube through a web
browser, or through a
dedicated app available for
the Mac, iPhone, iPad or
iPod Touch.
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